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Adobe Photoshop and Adobe Lightroom are natural partners in any photogra-
pher’s workflow. The question for photographers is not which of these power-
ful programs to use, but how best to use them together. That is the question 
this book is designed to answer. 

This section is important to read before diving into the rest of the book. It 
includes instructions for a few things you’ll have to do to work along with the 
lessons in this book:

• Downloading and storing the lesson files for this book

• Creating a new Lightroom catalog for use with this book

This section also covers topics that are critical to understanding when to use 
Lightroom and Photoshop together, including:

• How Lightroom and Photoshop differ

• Where Lightroom excels in a photographer’s workflow

• Where Photoshop excels in a photographer’s workflow

If you need additional help with Lightroom and Photoshop, you’ll also find 
useful resources in this section.

Why to use both Lightroom and Photoshop
There are solid reasons to use both Lightroom and Photoshop in your photo 
workflow. The two programs differ in significant ways, and each program 
excels at particular tasks. 

How Lightroom and Photoshop differ
At first glance, you might think that Lightroom and Photoshop do the same 
thing, which is to provide tools for enhancing your photographs. Of course, 
there is some overlap in that sense, but a closer look reveals that Lightroom 
and Photoshop differ in two important ways: what they do and how they do it.

When it comes to what the two programs do, Lightroom is broader and 
Photoshop is deeper. Lightroom was designed to cover a photographer’s entire 

GETTING STARTED
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post-capture workflow. So Lightroom includes features for doing all the following 
to photographs and video clips: offloading from camera to computer, organizing, 
finding, editing, sharing, and outputting in various ways. Photoshop is focused on a 
single task: editing. 

When it comes to how the two programs operate, Photoshop and Lightroom are 
quite different under the hood. Photoshop is a pixel editor. It works by altering pix-
els. Workarounds (like adjustment layers and Smart Objects) have been developed 
for editing nondestructively inside Photoshop. But ultimately, Photoshop operates 
by changing pixels. 

Lightroom’s Develop module works in a very different way. It is a parametric editor, 
which means that it operates by recording instructions rather than by altering pix-
els. When you change any parameter in Lightroom, that change is recorded as an 
instruction in a database (the Lightroom catalog) and is reflected in the image pre-
view in Lightroom. But that change is not actually applied to a photograph unless 
and until you output a copy of the photograph. Even then, the master photograph 
remains unchanged. So Lightroom, unlike Photoshop, is a truly nondestructive edi-
tor. You’ll learn more about how Lightroom’s Develop module works in Lesson 4, 
“Processing Photos in Lightroom’s Develop Module.”

Understanding these underlying ways in which Photoshop and Lightroom differ 
leads to a more practical issue—which of the two programs you should use for 
which tasks. That subject, which is addressed throughout this book, is summarized 
in the next two sections.

Where Lightroom excels
Lightroom shines at performing many essential tasks in a photographer’s workflow, 
including the following: 

• Photo management

Lightroom’s Library module is a sophisticated data asset manager. It is a 
database that contains a record of every photograph and video clip you import 
into Lightroom. That record includes metadata from the camera, information 
you add in Lightroom (like copyright, ratings, and keywords), and your Develop 
adjustments. Lightroom’s Library module has many features to help you 
import, organize, and find photographs and video clips, as detailed in Lesson 3, 
“Managing Photos in Lightroom’s Library Module.”

Photoshop does not include an asset manager. You can use Photoshop with 
another application, Adobe Bridge, but Bridge is just a file browser. It is not a 
database like Lightroom and does not have all the photo organizing capabilities 
that Lightroom offers.
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• Raw processing

Lightroom excels at processing raw files (although you can edit TIFFs, PSDs, 
JPEGs, and PNGs in Lightroom’s Develop module too). Lightroom’s built-in raw 
converter translates the raw data captured by your camera into a form that you 
can view and work with onscreen. 

Lightroom maintains the high bit depth captured in a raw file and applies its 
edits to your raw files nondestructively. Therefore, it makes sense to do as much 
processing to a raw file in Lightroom as you can. Then, if there is something to 
add that you can do only in Photoshop (like compositing) or that you can do 
better in Photoshop (like high-level portrait retouching), hand off the file to 
Photoshop for those purposes.

Photoshop has a plug-in, Adobe Camera Raw, that also processes raw files, 
using the same underlying engine as Lightroom. You’ll learn how Camera 
Raw integrates with Lightroom in Lesson 2, “Lightroom–Photoshop 
Roundtrip Workflow.”

• Simplified photo adjusting

Common photo adjustments (to color, tone, noise, sharpness, and lens 
distortions) are relatively simple to perform in Lightroom. That’s because the 
controls in Lightroom’s Develop module are discoverable, fairly easy to operate, 
and logically arranged so as to suggest a workflow. You’ll learn more about the 
ease of use of these controls in Lesson 4.

Photoshop is a more mature application. It has many more features and 
options than Lightroom, and it requires knowledge of techniques that are not 
necessarily obvious on the surface. 

• Processing multiple photographs

Lightroom is designed to minimize time and effort for high-volume 
photographers. The Lightroom workflow accommodates processing a lot of 
photographs relatively quickly, and Lightroom includes synchronizing features 
that simplify applying the same adjustments to multiple photographs. Batch-
processing multiple photographs in Photoshop is more complex.

• Sharing and outputting

Lightroom includes many features for sharing photographs (like Publish 
Services, in the Library module) and for outputting photographs (including the 
Book, Slideshow, Print, and Web modules). These features are outside the scope 
of this book, but you can learn more about some of them in Adobe Lightroom 5 
Classroom in a Book.
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Where Photoshop excels
Photoshop is unmatched when it comes to creative editing and precise correc-
tions. There is no need to bring every photograph you manage in Lightroom into 
Photoshop, but a round-trip from Lightroom to Photoshop and back will pay off in 
the situations covered in detail in Lessons 5 through 8 of this book.

• Combining photographs 

Techniques that involve combining multiple photographs cannot be performed 
in Lightroom. Making layered composites, merging bracketed exposures into 
a single high dynamic range (HDR) photograph, blending photographs into a 
panorama, and using linked Smart Objects are all done in Photoshop. Lesson 5, 
“Lightroom to Photoshop for Combining Photos,” includes compositing 
projects like these.

• Making precisely targeted adjustments

Lightroom offers some useful local adjustment tools: the Adjustment Brush, 
Graduated Filter, Radial Filter, and Spot Removal tools, all covered in Lesson 4. 
But when you want to get precise about local adjustments, you’ll pass images 
to Photoshop to take advantage of selections, masks, and adjustment layers. 
Lesson 6, “Lightroom to Photoshop for Selecting and Masking,” covers common 
situations in which you’ll use these Photoshop features, including replacing a 
dull sky, isolating a complex object using a channel mask, and selecting hair.

• Photo retouching

Photoshop is the place to go to alter pixels, whether your goal is to remove an 
item from a photograph or to perform intricate portrait retouching. Photoshop 
offers a variety of content-aware tools, tool options, layers, and other features 
for casual as well as professional photo retouching. You’ll practice using these 
features in Lesson 7, “Lightroom to Photoshop for Retouching.”

• Adding non-photographic elements

Embellishing photographs with non-photographic elements is a task for 
Photoshop. In Photoshop you can add text effects, graphics, filters, layer 
styles, and other non-photographic elements. You’ll work with some of these 
capabilities in Lesson 8, “Lightroom to Photoshop for Special Effects.”

Accessing the Classroom in a Book files
In order to work through the exercises in this book, you’ll need to download the 
sample image files from your Account page at peachpit.com. You can either down-
load the entire Lessons folder before you begin, or download the files for individual 
lessons as you need them.
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Your Account page is also where you’ll find any updates to the lesson files or 
to the book content. Look on the Lesson & Update Files tab to access the most 
current content.

Downloading the lesson files
1 Go to www.peachpit.com/redeem, and enter the code found at the back of 

this book. If you don’t yet have a Peachpit.com account, follow the prompts to 
create one.

2 Click the Lesson & Update Files tab on your Account page to see a list of 
downloadable files. Click the links to download either the entire Lessons folder 
or the work folders for individual lessons to your computer.

3 Create a new folder inside the Users/username/Documents folder on your 
computer. Name the new folder LPCIB.

4 If you download the entire Lessons folder, drag that Lessons folder into the 
LPCIB folder you created in step 3. 

Alternatively, if you download work folders for one or more individual lessons, 
first create a Lessons folder inside your LPCIB folder; then drag the individual 
lesson folder[s] into your LPCIB/Lessons folder.

5 Keep the lesson files on your computer until you’ve completed all the exercises.

The downloadable sample images are practice files, provided for your personal 
use in these lessons. You are not authorized to use these files commercially, or to 
publish or distribute them in any form without written permission from Adobe 
Systems Inc. and the individual photographers who took the pictures, or other 
copyright holders.

Creating a Lightroom catalog 
for use with this book
A Lightroom catalog is a database that stores information about the photographs 
and video clips you import into a Lightroom library. Many photographers use a 
single catalog for all their Lightroom photographs, but you can make a separate 
catalog for a special purpose, like managing the lesson files for this book.

1 Launch Lightroom.

When you first launch Lightroom, a default Lightroom catalog is created in 
Users/username/Pictures/Lightroom. If you’re using Lightroom 5, the name of 
the default catalog file is Lightroom 5 Catalog.lrcat. If you want to see the name 
of the current catalog at the top of Lightroom, press Shift-F several times to 
cycle to Normal screen mode.

http://www.peachpit.com/redeem
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2 Choose File > New Catalog in the menu bar at the top of the Library module.

3 In the Create Folder with New Catalog dialog that opens, navigate into the 
LPCIB folder in your Documents folder (Users/username/Documents/LPCIB) 
and enter LPCIB Catalog as the name of the new catalog.

4 Click Create. If you see a Back Up Catalog message, click the button labeled 
Skip this time.

This opens your new, empty LPCIB catalog. 
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Under the hood, you’ve created an LPCIB Catalog folder inside your Documents/
LPCIB folder that contains the catalog files for your new LPCIB catalog.

You will import the lesson files into this LPCIB catalog lesson by lesson, start-
ing in Lesson 1, “Getting Ready to Use Lightroom with Photoshop,” in the section 
“Importing from a drive.” That section contains a detailed explanation of the import 
process you’ll use throughout the book and when you’re working with your own 
photographs. It walks you through the process of importing any files from a com-
puter drive into Lightroom, using the Lesson 1 files as an example. 

In each subsequent chapter (Lessons 2 through 8) you’ll import the lesson files for 
that particular lesson by following the short instructions in the section “Preparing 
for this lesson,” which you’ll find at the beginning of Lessons 2 through 8. If at any 
time you want more information about how to import any lesson files, review the 
section “Importing from a drive” in Lesson 1.

About Classroom in a Book
Adobe Lightroom and Photoshop for Photographers Classroom in a Book® is part of 
the official training series for Adobe graphics and publishing software, developed 
with the support of Adobe product experts. The lessons are designed to let you 
learn at your own pace. If you’re new to Adobe Lightroom or Adobe Photoshop, 
you’ll learn the fundamental concepts and features you’ll need to work with these 
programs together. If you’ve been using Lightroom or Photoshop for a while, you’ll 
find that Classroom in a Book teaches advanced features too, focusing on tips and 
techniques for using the latest versions of the applications together. 

Although each lesson provides step-by-step instructions for creating a specific 
project, there’s room for exploration and experimentation. You can follow the book 
from start to finish, or do only the lessons that match your interests and needs. 
Each lesson concludes with review questions highlighting important concepts 
from that lesson.
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Prerequisites
Before starting on the lessons in this book, make sure you have a working knowl-
edge of your computer and its operating system. Also make sure that your system is 
set up correctly and that you’ve installed the required software and hardware. You 
must purchase the software separately from this book.

To complete the lessons in this book, you’ll need to have installed Adobe Lightroom, 
Adobe Photoshop, and the latest update to Adobe Camera Raw for your version of 
Photoshop. At the time of this writing, Lightroom 5.4 and Photoshop CC 14.2.1 are 
the current versions of the applications. You are welcome to follow along with ver-
sions of the programs as far back as Lightroom 4 and Adobe Photoshop CS6, but in 
that case some exercises in the book may not work for you exactly as written.

For system requirements and complete instructions for downloading, installing, 
and setting up the software, see the topics listed under the “Up and running” sec-
tion of helpx.adobe.com/photoshop.html and helpx.adobe.com/lightroom.html.

Getting help
Help is available from several sources, each one useful to you in different circumstances:

Help in the applications
The complete user documentation for Adobe Lightroom and Adobe Photoshop is 
available from the Help menu in each program. This content will display in your 
default web browser. This documentation provides quick access to summarized 
information on common tasks and concepts, and can be especially useful if you are 
new to Lightroom or if you are not connected to the Internet.

The first time you enter any of the Lightroom modules, you’ll see module-specific 
tips that will help you get started by identifying the components of the Lightroom 
workspace and stepping you through the workflow. You can dismiss the tips if 
you wish by clicking the Close button (x) in the upper-right corner of the float-
ing tips window. Click the Turn Off Tips check box at the lower left to disable the 
tips for all of the Lightroom modules. You can call up the module tips at any time 
by choosing Help > Module name Tips. In the Lightroom Help menu you can also 
access a list of keyboard shortcuts applicable to the current module.

Help on the web
You can also access the most comprehensive and up-to-date documentation on 
Lightroom and Photoshop via your default web browser. Point your browser to 
helpx.adobe.com/lightroom.html or helpx.adobe.com/photoshop.html. 

P Note: Throughout 
this book, if an 
instruction differs for 
a Windows or Mac 
operating system, you’ll 
see both commands 
separated by a forward 
slash (/): Windows 
command/Mac OS 
command.

P Note: If you’ve 
downloaded the Help 
PDFs, you don’t need 
to be connected to 
the Internet to view 
Help in Lightroom or 
Photoshop. However, 
with an active Internet 
connection you can 
access the most up-to-
date information.
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Help PDFs
Download PDF help documents, optimized for printing, at helpx.adobe.com/pdf/
lightroom_reference.pdf or helpx.adobe.com/pdf/photoshop_reference.pdf.

Additional resources
Adobe Lightroom and Photoshop for Photographers Classroom in a Book is not 
meant to replace documentation that comes with either program or to be a com-
prehensive reference for every feature. Only the commands and options used in the 
lessons are explained in this book. For comprehensive information about program 
features and tutorials, please refer to these resources:

Adobe Lightroom 5 Help and Support: You can search and browse Lightroom 
Help and Support content from Adobe at helpx.adobe.com/lightroom.html.

Adobe Photoshop CC Help and Support: You can search and browse Photoshop 
Help and Support content from Adobe at helpx.adobe.com/photoshop.html.

Adobe Forums: forums.adobe.com lets you tap into peer-to-peer discussions, 
questions, and answers on Adobe products.

Adobe Creative Cloud Learn: helpx.adobe.com/creative-cloud/learn/tutorials.html  
provides inspiration, key techniques, cross-product workflows, and updates on 
new features. 

Adobe TV: tv.adobe.com is an online video resource for expert instruction and 
inspiration about Adobe products, including a How To channel to get you started 
with your product.

Resources for educators: www.adobe.com/education and edex.adobe.com offer a 
treasure trove of information for instructors who teach classes on Adobe software. 
Find solutions for education at all levels, including free curricula that use an inte-
grated approach to teaching Adobe software and that can be used to prepare for 
the Adobe Certified Associate exams.

Also check out these useful links:

Adobe Photoshop Lightroom 5 product home page: 
www.adobe.com/products/photoshop-lightroom.html

Adobe Photoshop CC product home page:  
www.adobe.com/products/photoshop.html 

Adobe Authorized Training Centers
Adobe Authorized Training Centers offer instructor-led courses and training 
on Adobe products, employing only Adobe Certified Instructors. A directory of 
AATCs is available at partners.adobe.com.

http://www.adobe.com/education
http://www.adobe.com/products/photoshop-lightroom.html
http://www.adobe.com/products/photoshop.html
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PROCESSING PHOTOS 
IN LIGHTROOM’S 
DEVELOP MODULE

Lesson overview
The Develop module offers controls you can use to correct and 
enhance your photographs. This lesson covers the most essen-
tial adjustments in Lightroom’s Develop module. Topics in this 
lesson include:

• Global editing in the Basic panel

• Working with local adjustment tools

• Using the Tone Curve panel to fine-tune contrast

• Using the HSL panel to fine-tune color

• Making lens corrections

• Reducing noise

• Sharpening

You’ll probably need from 2 to 2 1/2 hours to complete this lesson.

4
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Photograph © John M. Lorenz 2012

Use the intuitive controls in Lightroom’s Develop 
module to adjust color, tone, and composition 
without changing the pixels in your photographs. 
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Preparing for this lesson
Do the following to prepare for this lesson:

1 Make sure you’ve followed the instructions in the Getting Started lesson at 
the beginning of this book for setting up an LPCIB folder on your computer, 
downloading the lesson files to that LPCIB folder, and creating an LPCIB 
catalog in Lightroom.

2 If the Lesson 4 files are not already on your computer, download the Lesson 4 
folder from your account page at www.peachpit.com to username/Documents/
LPCIB/Lessons.

3 Open the LPCIB catalog you created in the Getting Started lesson by doing the 
following: Hold the Alt/Option key as you start Lightroom; then in the Select 
Catalog dialog, select the LPCIB Catalog.lrcat file and click the Open button.

4 Import the Lesson 4 files into the open LPCIB catalog following the bullet steps 
below. This is similar to the process for importing any photographs that are 
already on a drive (see “Importing from a drive” in Lesson 1 for more details):

• Click the Import button in the Library module.

• In the Import window’s Source panel, navigate to username/Documents/
LPCIB/Lessons, and select the Lesson 4 folder. Make sure the Include 
Subfolders check box at the top of the Source panel and to the right of the 
Files label is checked.

• In the Import window’s workflow bar, choose Add as the import method.

• Leave all the thumbnails in the Import window checked.

• In the File Handling panel on the right side of the Import window, 
choose Build Previews > Standard. Leave the other File Handling 
options unchecked.

• In the Apply During Import panel on the right side of the Import window, 
enter Lesson 4 in the Keywords field.

• Click the Import button at the bottom right of the Import window.

5 In the Library module, select the Lesson 4 subfolder in the Folders panel.

http://www.peachpit.com
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Photo editing in Lightroom
Understanding how Lightroom’s editor works and planning your Lightroom–
Photoshop editing workflow will help you make the best use of Lightroom’s 
Develop module.

How Lightroom’s editor works
Lightroom uses a parametric editing system, which means that when you adjust a 
photograph in Lightroom you simply are creating a set of parameters or instruc-
tions for how to interpret the image data. You are not changing image pixels, as you 
do in a pixel editor like Photoshop. This makes Lightroom a truly nondestructive 
editor and one that is flexible to use.

How does this parametric editing system work? When you make adjustments in 
the Develop module, the adjustments are recorded as instructions in the Lightroom 
catalog. These instructions control the appearance of the image previews you see 
and work with in Lightroom. To help other programs see your Lightroom adjust-
ments, you can choose to save the instructions back to the photographs too, 
without altering the actual image data in the photographs, as explained later in this 
lesson in “Saving metadata to files.” If you output photographs from Lightroom, 
the instructions will be applied to the derivative copies that are generated, but your 
originals will remain unchanged.

The important point is that none of the adjustments you make in Lightroom will 
alter the image data in your original photographs.

This system makes editing in Lightroom not only nondestructive, but very flex-
ible too. For example, a Develop adjustment made to a raw file in Lightroom can 
be changed or deleted at any time, since all you’re doing is tweaking an instruc-
tion. Batch processing in Lightroom is as simple as copying and pasting instruc-
tions among multiple photographs. You can even experiment with different sets 
of instructions on a single photograph without making actual copies of that 
photograph, using a feature called virtual copies, as you’ll do later in this lesson in 
“Working with virtual copies.”

Photo editing workflow
If you shoot raw files, a recommended workflow is to do the bulk of your photo 
editing in Lightroom’s Develop module first—correcting tone and color, removing 
spots, reducing noise, performing initial sharpening, fixing perspective and other 
lens-related issues, and sometimes making local adjustments. It’s best to perform 
these fundamental corrections on photographs in their raw state (DNGs or propri-
etary raw files), because raw files offer the most editing latitude. 
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Then, if particular photographs call for specific edits that are best done in 
Photoshop (like detailed retouching, compositing, or the other Photoshop 
techniques covered in this book), pass those photographs from Lightroom to 
Photoshop, which creates RGB derivatives of the original raw files, as covered in 
more detail in Lesson 2.

Although Lightroom’s Develop controls are tailor-made for raw files, you can use 
them to adjust JPEGs, TIFFs, PSDs, and PNGs too. However, you may experience 
less editing flexibility than with raw files, and some of the Develop features will 
behave differently on RGB images than on raw files, as you’ll see in the section 
“White balancing” in this lesson.

The Develop module workspace
This section introduces the Develop module workspace and offers some tips for 
working efficiently in this module. The Develop module looks and behaves a lot 
like the Library module. Some of the Develop module features mentioned here are 
covered in more depth in the context of the Library module in the Lesson 3 section 
“The Library module workspace.”

Interface overview
The Develop module interface is similar to the Library module interface. The main 
elements of the Develop module interface are: 

A The center work area with a live preview of the photograph you’re adjusting.

B A column of adjustment panels and tools on the right side of the module. 

You’ll spend a lot of time working in the right panel column. This column 
contains a live histogram that updates as you adjust a photograph, a tool strip 
of local adjustment tools, the important Basic panel, and other panels with 
adjustment controls for correcting and enhancing photographs.

C A column of panels on the left side of the module.

The left panel column contains the Navigator panel for zooming and panning, 
the Presets panel for applying pre-built sets of adjustments, the Snapshots 
panel for saving adjustments at a particular point in time, the History panel 
for stepping forward and backward through adjustments over time, and the 
Collections panel for accessing photographs in collections without jumping 
back to the Library module.



ADOBE LIGHTROOM AND PHOTOSHOP FOR PHOTOGRAPHERS CLASSROOM IN A BOOK 121

D The Filmstrip at the bottom of the module, which displays thumbnails of 
photographs in the current source.

The Filmstrip plays an important role in the Develop module. It allows you to 
select a different image to work on from the current source without jumping 
back to the Library module.

E The bar at the top of the Filmstrip, which offers access to filename and folder 
information, other image sources, and some filters, so you don’t have to switch 
to the Library module for those items. 

E Tip: To access sources of other photographs without switching to the Library module, click the 
down-facing arrow on the bar at the top of the Filmstrip. From the pop-up menu, choose Recent 
Sources, All Photographs, Quick Collection, Previous Import, or sources you’ve marked as favorites.

F The toolbar above the Filmstrip, in which the features change depending on 
whether you’re making global adjustments or working with particular local 
adjustment tools.

G The menu bar at the top of the screen.

H The Module Picker bar at the top of the module (which is closed in the following 
illustration). 

A
BC

D

E
F

G H

E Tip: If the toolbar 
goes missing from 
the Develop module, 
press T to bring it back 
into view.
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Customizing the Develop module
You can customize the layout and panel behavior of the Develop module to your 
taste. Try these tips to make your workspace more user-friendly.

1 In the Library module, with the Lesson 4 subfolder selected in the Folders panel, 
select DSC0149.dng (a photograph of rooftops in Paris).

2 In the Library module, press D on the keyboard (or click Develop in the Module 
Picker) to switch to the Develop module.

The Develop module opens with the selected image in the center work area. 
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3 If the left panel column, the Filmstrip, or the Module Picker bar is open, click 
the thin black border outside each of those open items.

This is a useful setup for working in the Develop module. If you need to access 
the left column, click its outer border again to bring it back into view. If you 
need to access the Filmstrip, click its outer border again (or press F6 or fn-F6). 

4 Right-click/Control-click the header of any  
panel in the column on the right, and choose 
Solo Mode from the panel list pop-up menu. 
(Or Alt/Option-click the header of any panel 
in that column.)

This puts all the panels in the column in Solo 
mode, which means that only one panel will 
stay open at a time. This reduces the amount 
of scrolling you’ll do to access the many panels 
and controls in this column, particularly if 
you’re working on a small screen.

E Tip: If a panel that you expect to see in a Develop module column is missing, right-click/Control-
click the header of any panel in that column to open the panel list pop-up menu. Select the missing 
panel name in that menu. 
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Develop module shortcuts
In the Develop module, you can hide and show interface elements and change 
views by using some of the same shortcuts as in the Library module. The following 
shortcuts are among those you’ll use most as you work in the Develop module. To 
view an overlay of module-specific shortcuts in the Develop module, choose Help > 
Develop Module Shortcuts. Click the overlay to close it.

• To hide or show all the columns and bars (the Filmstrip on the bottom, the 
Module Picker bar on the top, and the columns of panels on the left and right), 
press Shift-Tab on the keyboard.

• To hide or show the left and right panel columns together, press Tab on the 
keyboard. 

• To hide or show a bar or column individually, press F5 or fn-F5 for the Module 
Picker bar, press F6 (or fn-F6) for the Filmstrip, or click the thin black border 
outside any bar or column. 

If a bar or column is set to Auto Hide & Show, causing it to pop in and out 
of view, you may prefer changing its hide and show behavior to Manual, as 
described in the Lesson 3 section “Customizing the Library module.”

• To cycle through screen modes, press Shift-F on the keyboard. 

• To toggle Full Screen mode on and off, press F on the keyboard.

• To cycle through useful displays of image information on the photograph, press 
I on the keyboard. 

• To hide or show the toolbar, press T on the keyboard.

Zooming and panning in the Develop module
Zooming and panning in the Develop module is similar to zooming and panning in 
the Library module.

1 With DSC0149.dng still open in the Develop module, click the thin black border 
on the far left to open the left panel column, and click the Navigator header at 
the top of that column to open the Navigator panel. 

Zoom-level options are listed along the top of the Navigator panel and in a 
pop-up menu at the top right of that panel. 

2 Make sure the zoom level in the Navigator panel is set to its default option, Fit. 

The Fit zoom level automatically zooms to a ratio that displays the entire 
photograph in the center work area.
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3 Click the photograph in the center work area (or press the spacebar). This 
magnifies the photograph to the 1:1 zoom level by default. 

The 1:1 zoom level displays one image pixel in one screen pixel, which is critical 
for evaluating sharpness and noise. 

When the photograph is zoomed in so close that you can’t see all of it in the 
work area, the cursor automatically changes to the Hand tool.
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4 With the Hand tool, drag the photograph  
around in the center work area so you 
can view different parts of it. This is 
known as panning.

Another way to pan the photograph 
in the center work area is to drag the 
edge of the frame overlay inside the 
Navigator panel.

Each time you click the photograph 
(or press the spacebar) the zoom level will toggle between Fit and 1:1 until you 
change one or both of these zoom levels. 

5 Click the triangle icons at the top right of the Navigator  
panel to open a menu of additional zoom levels. Choose 
3:1 from that menu. The photograph zooms in to a 3:1 
ratio of screen pixels to image pixels.

6 Click the photograph again, and it zooms out to Fit view. 
Now each time you click the photograph (or press the 
spacebar) the zoom level will toggle between Fit and 3:1. 

7 To reinstate the default behavior (toggling between the Fit and 1:1 zoom levels), 
click the 1:1 icon at the top of the Navigator panel. Switch to Fit view for the 
next section.

Undoing adjustments
As you adjust a photograph in the Develop module, you’ll often want to undo an 
adjustment or reinstate a previously made adjustment. The Develop module is very 
flexible in this regard. It offers the History panel, the Snapshots panel, and multiple 
ways to undo and reset.

1 With DSC0149.dng still open in the  
Develop module, in the panel column 
on the left, click the header of the 
Presets panel to open that panel.

The Presets panel contains Develop 
presets, which are groups of saved 
settings. Presets are a quick way to apply adjustments, so you’ll use them to set 
up these exercises about undoing adjustments.

2 In the Presets panel, click the triangle to the left of the Lightroom B&W Filter 
Presets folder to expand that folder. Click the Yellow Filter preset. This black 
and white Develop preset is applied to the photograph.
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3 Choose Edit > Undo (or press Ctrl-Z/Command-Z) to remove the Yellow Filter 
preset from the photograph.

The Undo command undoes your last action. Each time you apply the Undo 
command it moves back one more step. Undo is most useful when you want to 
roll back no more than a few steps.

4 Choose Edit > Redo (Shift-Ctrl-Z/Shift-Command-Z). The black and white 
Yellow Filter preset is re-applied.

The Redo command reinstates steps you’ve undone, one step at a time. 
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5 In the Presets panel, click the triangle to the left of the Lightroom B&W Toned 
Presets folder to expand that folder. Click the Sepia Tone preset. That preset is 
applied to the photograph.

6 Click the Reset button at the bottom right of the Develop module. This takes 
the photograph all the way back to its default settings, removing all the Develop 
adjustments you’ve applied.

The Reset command is useful for those times when you want to  
start over from the beginning. 
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7 In the Presets folder, click the triangle to the left of the Lightroom Color Presets 
folder to expand that folder. Click the Aged Photo preset.

8 In the Presets folder, click the triangle to the left of the Lightroom Effect Presets 
folder to expand that folder. Click the Grain–Heavy preset. Click the header of 
the Presets panel to close the Presets panel.

The Grain–Heavy preset and the Aged Photo preset display cumulative effects 
on the photograph. They do not cancel each other out, like multiple presets 
sometimes do, because they are composed of different adjustments.

9 Go to the Snapshots panel in the left panel column. Click the Create Snapshot (+)  
button on the right side of the Snapshots panel to capture a snapshot of the 
current edited state of the photograph.

10 In the New Snapshot dialog, you can  
accept the default name (the date 
and time of the snapshot) or type 
over it with a more meaningful 
name, like Aged Photo + 
Grain Heavy. 

11 Click Create in the New Snapshot dialog.  
The snapshot appears by name in the 
Snapshots panel.
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E Tip: A snapshot is useful if you want to hold onto an edit that you like but experiment with other 
adjustments too. You can quickly reapply a state you captured in a snapshot by opening the same 
photograph in the Develop module at any time and clicking the snapshot name in the Snapshots 
panel. All the snapshots you retain in the Snapshots panel will be available in the future, even after 
you close and reopen Lightroom.

E Tip: If you no longer need a snapshot, select it in the Snapshots panel and click the Minus icon at 
the top right of the Snapshots panel to delete it from the panel.

12 Click the triangle to the left of the History panel in the left panel column to 
open that panel.

The History panel keeps track of all Develop adjustments you make to a 
photograph—including individual settings—as chronological states in editing 
history. You can go backward or forward in the editing history of a photograph, 
re-applying any of its history states.

P Note: The History panel in Lightroom, unlike the  
History panel in Photoshop, is persistent. All 
existing history states for this photograph will be 
available in the History panel whenever this 
photograph is open in the Develop module— 
even after you close and reopen Lightroom.

13 In the History panel, click the history state labeled Preset: Sepia Tone. This 
applies that history state to the photograph in the work area. 
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In the History panel, there are more states above the one that is currently 
selected. If you make any other adjustment at this point, those states will 
disappear from the History panel, which keeps track only of linear history. To 
retain all the history to date, click the topmost history state before continuing to 
develop a photograph. Or to retain a particular state, take a snapshot of it.

If you ever want to remove all history states from the History panel, click the 
Clear All (x) icon at the top right of the History panel.

Comparing Before and After views
The best way to evaluate adjustments you’ve made to a photograph is often to com-
pare the adjusted photograph to the photograph you started with. There are several 
ways to do that in the Develop module.

1 With DSC0149.dng still open in the  
Develop module, click the Reset button 
at the bottom right of the Develop 
module to reset the photograph to its 
default appearance before you applied 
any adjustments.

2 In the Presets panel in the left panel 
column, click the arrow to the left of the 
Lightroom Color Presets folder to open 
that folder. Click the Old Polar preset to 
apply it to the photograph.

E Tip: Hover over 
history states one by 
one in the History panel 
to see them previewed 
on the photograph in 
the Navigator panel. 
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3 Press the Backslash key (\) on your keyboard to switch to Before view—a view 
of the photograph as it looked just after importing, before develop adjustments 
were applied. 

The Backslash key is a shortcut for View > Before/After > Before Only.

4 Press the Backslash key (\) again to return to After view—a view with the 
current adjustments (the Old Polar preset) applied.

Toggling between Before and After views can help you evaluate adjustments 
you’ve made. Another way to compare Before and After views is to see them 
together on the screen, as you’ll do in the next steps.

5 If your toolbar isn’t showing at the bottom of the module, press T on the 
keyboard. 

6 The default view in the Develop module is Loupe view, a single After view that 
updates as you apply adjustments. To switch from Loupe view to Before and 
After views of the open photograph, click the Before and After Views button 
(the button with the YY icon) in the toolbar (or press Y on the keyboard). 

When a Before and After view is active, the toolbar displays additional 
Before & After buttons for copying and swapping settings between Before 
and After versions.
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7 There are four Before and After views to choose from: Left/Right, Left/Right 
Split, Top/Bottom, and Top/Bottom Split. Click the Before and After Views 
button in the toolbar several times to cycle through the Before and After views. 
Or click the triangle to the right of the Before and After Views button and 
choose a view option from the pop-up menu. 

• Before/After Left/Right 

• Before/After Left/Right Split 

• Before/After Top/Bottom 

• Before/After Top/Bottom Split

8 To return to Loupe view from any of the Before and After views, click the Loupe 
view button in the toolbar (or press D on the keyboard).

You can also access Before and After views of all the adjustments made in a panel, 
all the adjustments made in a panel section, and individual adjustments, as covered 
in “Working with the sliders” in this lesson.

Developing photographs
Lightroom, as a raw converter, does its best to interpret the raw data captured 
by your camera to render an image that you can view and work with onscreen. 
However, that rendering is only an initial interpretation of the raw data. The con-
trols in the Develop module give you the opportunity to fine-tune that interpreta-
tion. If you’re not satisfied with the initial appearance of a raw image in Lightroom, 
don’t be too quick to reject the photograph. You’ll be surprised at the latitude you 
have to correct color, recover highlight detail, and otherwise enhance the appear-
ance of images rendered from raw files. 

In this section, you’ll apply Develop module controls to raw photographs. You can 
work with RGB images in the Develop module too.

P Note: As you work 
through this lesson 
and the book, you do 
not have to use the 
exact value for each 
adjustment that you 
see in the illustrations. 
Choose values that look 
good to you on your 
monitor. The values in 
the illustrations indicate 
the general direction 
of adjustments and 
approximate values only.
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Adjusting color and tone in the Basic panel
The Develop module’s Basic panel contains controls for making fundamental global 
corrections to color and tone. Global corrections are those that affect the entire 
photograph, as opposed to local corrections, which affect just part of an image. 
You’ll apply Basic panel adjustments to most photographs you process in the 
Develop module, so it’s important to have a thorough understanding of the Basic 
panel controls.

Working with the sliders

The Basic panel contains sliders divided into three main sections:

• The WB (White Balance) section controls  
color balance.

• The Tone section controls exposure, contrast, 
and specific tonal values.

• The Presence section controls intensity of tone 
and color.

There’s also a narrow Treatment section at the top 
of the Basic panel where you can click between 
Color and Black & White labels (or press V on the 
keyboard) to quickly see how a color photograph 
will look converted to black and white.

Before digging in to apply Basic panel sliders, here are some tips that will help you 
use the sliders efficiently.

1 With DSC0419.dng still open in the Develop module, click the header of the Basic 
panel in the right panel column to open the Basic panel.

2 Drag the Exposure slider in the Basic panel to the right to lighten the 
photograph. (The value you choose doesn’t matter for this step.) Then double-
click the slider control (or double-click the slider label) to return the slider to its 
default value of 0.

To return any slider in the Basic panel to its default value, double-click the slider 
control or the slider label. 

The Exposure slider and the other sliders in the Tone and Presence sections of 
the Basic panel default to 0, in the middle of each slider. The sliders in the White 
Balance section default to the white balance settings captured by the camera.

3 An alternative to dragging a slider is to move it in increments for more control. 
Click the Exposure slider’s label to activate that slider; then use the Plus (+) 
and Minus (–) keys on the keyboard to move the slider by preset increments. 
Double-click the slider control or label to reset the slider.

E Tip: To compare 
Before and After 
views of a single slider 
adjustment, double-
click the slider control 
(or the slider label) 
to return the slider to 
its default value (the 
Before view); then press 
Ctrl-Z/Command-Z to 
undo, which returns the 
slider to its last adjusted 
value (the After view).
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Holding the Shift key during this process moves a slider in larger increments. 
Holding the Alt/Option key moves it in smaller increments.

Another way to move a slider in increments is to hover over the slider and 
press the Up Arrow or Down Arrow key on your keyboard to move that slider 
in increments. The same modifier keys apply to this method: Shift for larger 
increments, and Alt/Option for smaller increments.

4 Adjust a few sliders in the Tone section of  
the Basic panel. (The values you choose don’t 
matter for this step.) To return all the sliders in 
this section to their default values of 0, double-
click (or Alt-click/Option-click) the Tone label 
at the top of the section. 

To return all sliders in the Presence section to 
their defaults, double-click (or Alt-click/Option-
click) the Presence label at the top of that section. 
To return all sliders in the White Balance section 
of the Basic panel to their defaults, double-click 
the WB label in that section.

P Note: To compare Before and After views of all adjustments made in the Basic panel, in the 
History panel click the state just beneath the first Basic panel adjustment (the Before view). 
Then press Ctrl-Z/Command-Z (the After view). Each of the other panels in the right panel column 
has a panel switch  in its header for toggling Before and After views of all adjustments made in 
that panel. The Basic panel has no such panel switch.

5 If the Histogram panel at the top of the Develop module’s right panel column is 
not open, click its header to open it.

6 Hover over the Highlights slider in the Basic  
panel and notice the light gray overlay that 
appears in the histogram. Repeat this with each 
of the other sliders in the Tone section. 

The overlay in the histogram indicates the part 
of the tonal range that will be most affected 
by adjusting a particular slider. Each slider in 
the Tone section has its primary effect on a 
different area of the histogram (although other 
areas are tangentially affected too). 

E Tip: To set a slider 
to a particular value, 
click in the field to the 
right of the slider, type a 
value, and press Enter/
Return. For example, if 
you know you want to 
increase exposure the 
equivalent of one stop, 
type 1 in the Exposure 
field to change the 
Exposure value to +1.00.
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The significance of process version
The instructions in this book, particularly instructions that concern the Basic panel, 
are for the current Lightroom process version—PV 2012, which was introduced 
in Lightroom 4. Process version means Lightroom’s underlying image processing 
technology, which changed significantly with PV 2012. Some of the Basic panel slid-
ers look and behave differently in PV 2012 than they do in previous process versions.

How does the current process version affect photographs that you adjusted in 
a previous process version? If you like the way a photograph looks with its older 
processing, it’s fine to leave that photograph as is. If you want to re-adjust the 
photograph to take advantage of improvements in PV 2012, open it in the Develop 
module. At first, the Basic panel sliders will look different than the current PV 2012 
sliders. Click the lightning icon at the bottom right of the Histogram panel . Then 
click Update in the Update Process Version dialog. This replaces the older Basic panel 
controls with the PV 2012 sliders, and you can use them to re-adjust the photograph.

Updating a photograph you adjusted in an earlier process version can affect the 
appearance of the photograph, as the dialog warns. So although this dialog gives 
you the option to Update All Filmstrip Photos, it’s usually preferable to update one 
photograph at a time. 

Evaluating the photograph

Take the time to evaluate a photograph before making adjustments. Ask yourself 
whether the photograph is too bright or dark. Is it overly contrasty or flat? Is there 
detail missing from highlight or shadow areas? Is the color off?

The Histogram panel in the Develop module can  
help with this evaluation. The histogram displays 
the location of a photograph’s tones across a 
range, from black on the far left to white on the 
far right. For example, with DSC0149.dng open 
in the Develop module, the histogram looks like 
the following illustration. The lack of bars on the right and left sides of the histo-
gram indicates that there are no completely white tones and very few rich black 
tones in this photograph. This suggests that the photograph could be improved by 
setting a white point with the Whites slider and a black point with the Blacks slider.
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Leave the Histogram panel open. As you make adjustments to the photograph, 
check this live histogram to confirm the effects that your adjustments are having 
on tonal values.

Order of adjustments

There is no hard and fast technical requirement to make develop adjustments in a 
particular order. A common approach is to begin with the Basic panel, work your 
way down through the panels in the right panel column, and make most global 
adjustments before local adjustments.

There are a few workflow exceptions to this approach. If you decide to jump to the 
Camera Calibration panel to change the camera profile that Lightroom uses to ren-
der raw files, it’s logical to do that at the beginning of your Develop workflow, even 
though the Camera Calibration panel is at the bottom of the right panel column. 
And although most local adjustments are made after global adjustments, try to do 
local retouching with the Spot Removal tool before Lens Correction panel adjust-
ments to enhance accuracy and rendering performance. 

When you’re working in the Basic panel, a top-down approach is common; but 
don’t be afraid to stray from that order as necessary. For example, if a photograph is 
so dark that you can’t evaluate its color balance, increase the Exposure slider before 
tackling the White Balance controls at the top of the Basic panel. Or if you need to 
re-adjust a Basic slider that you’ve already set, feel free to go back and do that. 

White balancing

The overall color of a photograph reflects the color of the light illuminating the 
scene, which is measured as color temperature. Strictly speaking, the purpose of 
Lightroom’s white balance controls is to neutralize the color of light in order to 
remove unwanted color casts. However, there is no requirement to remove a color 
cast. In your subjective judgment you might elect to retain or even emphasize a 
color cast, like the warm gold in a sunset scene. In that sense, Lightroom’s white 
balance controls are color correction tools that you can use to convey a mood that 
meets your subjective photographic vision.

There are three kinds of controls in the WB (White Balance) section of the Basic panel:

• The Temperature and Tint sliders give you control over two axes of color. The 
Temperature slider ranges from cool blue to warm gold; the Tint slider ranges 
from green to magenta. You can use the sliders on their own or to fine-tune 
results from the other white balance controls.

• The white balance presets menu offers preset combinations of Temperature and 
Tint slider values. 

• The White Balance Selector tool is useful for neutralizing color.

You’ll apply all three white balance controls in this exercise.
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1 With DSC0149.dng (the photograph of the Paris rooftops) still open in the 
Develop module, click the Reset button at the bottom right of the module to 
reset any adjustments you’ve made so far. 

2 In the Basic panel, click the drop-down menu  
of white balance presets on the right side of 
the White Balance section and choose 
Daylight. This option shifts the Temperature 
slider to the right toward gold and the Tint 
slider to the right toward magenta on this 
photograph, warming the overall color.

The options in this drop-down menu are preset values for the Temperature 
and Tint sliders. The As Shot option reflects the white balance captured by 
the camera. (As Shot may not be available, depending on the camera settings.) 
The Auto option is Lightroom’s best guess from the image data about how to 
set the Temperature and Tint sliders. Each of the other presets is a different 
combination of these sliders.

3 Use the Temperature and Tint sliders to tweak the preset color balance to your 
taste. In the following illustration, the Tint slider was decreased slightly.

4 Press the Y key on the keyboard to compare Before and After views. 

The After view, on the right side of this illustration, is warmer in color than the 
Before version, on the left. 

5 Press the Y key again (or the D key) to toggle back to Loupe view.

6 Click the Plus icon (+) on the right side of the Snapshots panel. In the New 
Snapshot dialog, name this snapshot White Balance, and click Create. 

You’ll come back to this photograph in this state to make further adjustments 
later in this lesson. In the meantime, you’ll switch files for the next example, in 
which you’ll neutralize color using the White Balance Selector tool.

E Tip: Another 
way to set both the 
Temperature and Tint 
sliders to their Auto 
values is to Shift-
double-click the WB 
label in the White 
Balance section. If you 
want to set just the 
Temperature slider 
or just the Tint slider 
to its default value, 
Shift-double-click the 
control or label on 
that slider. To undo an 
auto adjustment, press 
Ctrl-Z/Command-Z.
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7 Open the Filmstrip by pressing F6 (or fn-F6) on the keyboard. In the Filmstrip, 
select 7073846.dng (a photograph of a Paris subway station), which has a strong, 
warm color cast.

8 Click the White Balance Selector tool  
(the eyedropper icon) in the White Balance 
section of the Basic panel.

This tool is most useful when there is an area 
in the photograph that you think should be 
neutral in color—like the tiles on the right side of the subway platform floor, 
which were light gray in the actual scene.

9 If the toolbar isn’t showing, press the T key on your keyboard. The toolbar now 
displays options specific to the White Balance Selector tool. In the toolbar, 
make sure the Auto Dismiss check box is unchecked and the Show Loupe check 
box is checked.

Unchecking Auto Dismiss will allow  
you to apply the White Balance 
Selector tool multiple times to get the 
result you want, without having to reselect the tool in the Basic panel each time. 
Checking Show Loupe will display a magnified view of the area under your 
cursor to help you pick a color to neutralize.

10 Hover the White Balance Selector tool over something that should be neutral in 
this photograph, like the floor tiles on the right side of the subway platform. 

The Loupe confirms that the color under the cursor is not neutral. If it were, the 
three RGB values at the bottom of the Loupe would be more similar.
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The Navigation panel on the left offers a live preview of the effect of the White 
Balance Selector tool. As you move the cursor in the image, you can see how 
the color would change if you were to click that spot with the White Balance 
Selector tool.

11 Click the floor tiles on the subway platform with the White Balance Selector 
tool to shift them from gold to neutral gray.

The rest of the colors in the image shift relative to that neutralized color, 
significantly reducing the warm color cast in this photograph.

If you don’t like the result, you can continue to click with the White Balance 
Selector tool on other objects that were gray or white in the actual scene. 
Depending on where you click, you’ll get very different results, potentially 
introducing another unwanted color cast elsewhere in the image. This makes 
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the White Balance Selector tool relatively unpredictable as compared to the 
other white balance controls. 

12 To deactivate the White Balance Selector tool,  
click the empty circle on the left side of the 
White Balance section of the Basic Panel. 
 

White balancing JPEGs
If you shoot JPEGs, you have less flexibility to set white balance in Lightroom than 
you do with raw files. That’s because white balance is already baked into JPEGs by 
your camera at the time of capture, which is not the case with raw files. 

Lightroom’s white balance controls are different for JPEGs than for raw files. When 
you’re working with a JPEG, you’ll see different values on the Temperature and Tint 
sliders and fewer options in the white balance presets menu.

Trying out Auto adjust

The six sliders in the Tone section of the Basic  
panel control the tonal values in a photograph. The 
default for all these sliders is 0. The Auto button at 
the top right of the Tone section sets all the sliders 
in the Tone section to automatically calculated 
values. Some photographers shy away from the 
Auto button, but you might give it a try if you’re short on time or want a quick read 
of how a photograph will look with tone adjustments. To return all the sliders in 
the Tone section back to their defaults, double-click the Tone label at the top left of 
the Tone section.

E Tip: To set an 
individual tone slider 
to its Auto value, Shift-
double-click the control 
or label on that slider. 
Double-click the control 
or label on that slider 
again to return it to its 
default value.
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Adjusting exposure and contrast

The first sliders at the top of the Tone section in the Basic panel are Exposure and 
Contrast. The Exposure slider controls the overall brightness of a photograph. The 
Contrast slider affects the overall contrast. 

1 If the Filmstrip is not open at the bottom of the Develop module, press F6 (or 
fn-F6) on the keyboard. In the Filmstrip, select DSC0149.dng (the photograph 
of the Paris rooftops you last worked with in the section “White balancing”).

2 Make sure the white balance controls are as you set them for this photograph 
in the “White balancing” section. If you created a snapshot to record your 
white balance settings, as suggested in that section, click that snapshot in your 
Snapshots panel now.
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3 Hover over the Exposure slider in the Basic panel. 

A light gray overlay appears in the center of 
the histogram in the Histogram panel. This 
represents the tonal range on which the 
Exposure slider has its primary effect— 
the midtones.

4 Drag the Exposure slider to the right from its  
default of 0.

Dragging the Exposure slider to the right 
increases the overall brightness of a photograph. The tones—particularly the 
midtones—move to the right on the histogram. Dragging the Exposure slider to 
the left would decrease overall brightness.

5 Click the label on the Contrast slider to activate that slider. Then press the Plus 
(+) key on your keyboard to increase contrast in this photograph slightly. 

When you’re making small moves to a slider,  
this and the other incremental methods of 
setting a slider, covered earlier in “Working 
with the sliders,” offer finer control than dragging. 

Contrast refers to the range of tones in an image.  
When you increase the Contrast slider, tones are 
pushed apart across the tonal range, with light 
tones getting lighter and dark tones darker except 
at the extreme light and dark ends of the tonal 
range. This is similar to the effect of an s-shaped 
tone curve, which has a steep slope in the middle, 
where contrast is high, and a relatively flat top and 
bottom, where contrast is lower. 

You don’t have to apply the Contrast slider to every image, but increasing 
contrast with this slider can benefit photographs that are lacking in contrast to 
varying degrees. On the other hand, if a photograph is too contrasty, moving 
the Contrast slider to the left will compress tones along the tonal range and 
reduce contrast. 

P Note: The Exposure, 
Highlights, Shadows, 
Whites, and Blacks 
sliders in the Basic panel 
each have a primary 
effect on a different 
area of the tonal range, 
with secondary effects 
on other parts of the 
tonal range.

P Note: Exposure 
slider values simulate 
stops on a camera. 
Setting Exposure to 
+1.00 is like exposing 
one stop over the 
metered exposure in 
camera.

P Note: Increasing 
contrast may also 
increase color 
saturation. In that case, 
you can use global 
or local saturation 
controls, addressed 
later in this lesson, to 
tame the increased 
saturation. 
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6 Toggle the Backslash key (\) on the keyboard to compare Before and After views 
of your adjustments to this point. 

7 Leave the photograph open for the next section.

Adjusting highlights and shadows

The Highlights and Shadows sliders fine-tune contrast in light and dark areas of a 
photograph, respectively. The Highlights slider is very useful for recovering high-
light detail. The Shadows slider is useful for revealing detail in dark areas.

1 With DSC0149.dng (the photograph of the  
Paris rooftops) still open in the Develop 
module, hover over the Highlights slider in the 
Basic panel. A light gray overlay appears over 
the 1/4-tone highlights in the Histogram panel, 
representing the tonal range on which the 
Highlights slider has its primary effect. Notice 
that this is not the brightest area of the 
histogram, which is on the far right.
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2 Drag the Highlights slider to the left of its  
default of 0.

Dragging the Highlights slider to the left 
darkens and separates the lighter tones in a 
photograph, with minimal impact on darker tones. The effect is to emphasize 
detail and edge definition in highlight areas, like the clouds in this photograph. 
The Highlights slider is most often used for this purpose, although it can also be 
dragged to the right to brighten highlights without clipping them.

3 Hover over the Shadows slider in the Basic  
panel. A light gray overlay appears over the 
3/4-tone shadows in the Histogram panel, 
representing the tonal range on which the 
Shadows slider has its primary effect. These 
tones are dark, but they are not the very 
darkest part of the tonal range. 
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4 Drag the Shadows slider to the right of its  
default of 0.

Dragging the Shadows slider to the right 
lightens and separates relatively dark tones in 
the photograph. The effect is to reveal detail in darker areas, like the shadows 
under the balconies in this photograph. The Shadows slider is most often used 
for this purpose, although it can also be dragged to the left to darken shadows 
without clipping them.

Dragging the Shadows slider to the right flattens contrast. To compensate, when 
you drag the Shadows slider to the right it’s often a good idea to drag the Blacks 
slider to the left, as you’ll do in the next section. This re-introduces contrast in 
dark areas.

5 Leave the photograph open for the next section.
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Setting white and black points

The Whites and Blacks sliders set the white and black points, respectively, at each end 
of the tonal range. Setting these points appropriately maximizes contrast while avoiding 
excessive clipping of image detail, which is particularly important in the highlights.

1 With DSC0149.dng (the photograph of the  
Paris rooftops) still open in the Develop 
module, hover over the Whites slider in the 
Basic panel. In the Histogram panel, a light 
gray overlay appears on the far right of the 
histogram, representing the tonal range on 
which the Whites slider has its primary effect.

2 Click the highlight clipping indicator  
(the triangle at the top right of the Histogram 
panel) to activate it. 

This indicator will add a red overlay to the image 
to show you the highlights that will be clipped as 
you drag the Whites slider to the right.

Highlight clipping turns the brightest parts of a photograph to pure white with 
no image detail. Highlight clipping is usually best to avoid, except in specular 
highlights (like highlights in shiny chrome).

3 Drag the Whites slider to the right until there is a red overlay over the brightest 
areas of the photograph. 

The red overlay is the highlight clipping indicator’s way of telling you which 
highlights will be clipped.

P Note: Another way 
to see which highlights 
will be clipped is to hold 
the Alt/Option key as 
you drag the Whites 
slider to the right. Areas 
clipped in all channels 
are white, areas 
clipped in one or two 
channels are in color, 
and unclipped areas 
are black.
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4 Drag the Whites slider back to the left until there are just a few specks of red 
overlay in the photograph. 

The red overlay indicates where highlight clipping will occur. The brightest tones 
in the image are clipped by pushing them off the right side of the histogram. 

5 Click the highlight clipping indicator in the Histogram panel again to 
deactivate it.

6 Hover over the Blacks slider in the Basic panel.  
In the Histogram panel, a light gray overlay 
appears on the far left side of the histogram, 
representing the tonal range on which the 
Blacks slider has its primary effect. 

7 Click the shadow clipping indicator (the 
triangle at the top left of the Histogram panel) 
to activate it. 

This indicator will add a blue overlay to the 
image to show you the shadows that will be 
clipped as you drag the Blacks slider to the left.
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8 Drag the Blacks slider to the left until there is a blue overlay over the darkest 
parts of the photograph in which you don’t mind losing detail. 

The blue overlay indicates where shadow clipping will occur.

Shadow clipping pushes the darkest tones off the left side of the histogram, 
introducing rich blacks into the image. Some shadow clipping is often desirable, 
particularly after you’ve dragged the Shadows slider to the right to open up 3/4-
tone shadow areas. You usually don’t have to be as careful about clipping blacks 
as you do about clipping whites, because in many photographs dark areas do 
not contain important details.

9 Click the shadow clipping indicator in the Histogram panel again to 
deactivate it.

10 Toggle the Backslash key (\) on the keyboard to compare Before and After views 
of your adjustments to this point. 

11 Leave the photograph open for the next section.

P Note: Another way 
to see which dark areas 
will be clipped is to 
hold the Alt/Option key 
as you drag the Blacks 
slider to the left. Areas 
that are clipped in all 
channels are black, 
areas clipped in one 
or two channels are in 
color, and unclipped 
areas are white.
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Adding positive or negative clarity

The Clarity slider in the Presence section of the Basic panel can have a big impact 
on a photograph. Dragging Clarity to the right adds punch to a photograph. 
Dragging Clarity to the left adds a soft glow.

1 Drag the Clarity slider to the left of its default  
of 0 to add negative clarity.

Negative Clarity adds a diffused glow that is a 
great way to soften a portrait or give a scene a dreamlike quality.

2 Drag the Clarity slider to the right of 0 to add  
positive clarity.

Positive clarity adds a special combination 
of midtone contrast and edge definition that 
brings out detail and adds punch to an image. In this photograph, for example, 
it emphasizes detail in the buildings and the edges of the clouds. To avoid the 
risk of visible halos at image edges, don’t be too aggressive with positive clarity.
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3 Leave the photograph open for the next section.

Controlling color saturation

The last two sliders in the Basic panel—Vibrance and Saturation—control color 
intensity. These sliders work in slightly different ways, so try them both on a photo-
graph before deciding which to apply.

1 Drag the Vibrance slider to the right of its  
default of 0 to increase the intensity of colors.

Dragging the Vibrance slider to the right 
increases color saturation in an intelligent way, 
by adding the most saturation to colors that 
need it most. Dragging this slider to the left 
would decrease saturation.
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The Vibrance slider is almost always a good choice for adding saturation to 
photographs of people, because it protects skin tone colors (including yellow 
and orange) from oversaturation. But in this case, dragging the Vibrance slider 
far enough to the right to saturate the yellows and oranges in the buildings 
causes the blue sky to become oversaturated.

2 Double-click the label or control on the Vibrance slider to return it to its 
default of 0.

3 Drag the Saturation slider to the right of its  
default of 0.

Increasing the Saturation slider saturates all 
colors in a photograph equally. This sometimes 
causes too strong an effect, but in this case increasing the Saturation slider 
adds intensity to the warm colors of the buildings without making the sky 
exceedingly oversaturated. You’ll use controls in the HSL panel to fine-tune the 
color of the sky in the section “Fine-tuning color in the HSL panel.”
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4 Press the Y key on the keyboard to compare the Before view on the left, 
which has no adjustments, with the After view on the right, which has all the 
adjustments you added in the Basic panel.

5 Press Y again to return to Loupe view.

6 Click the Plus icon (+) on the right side of the Snapshots panel to capture a 
snapshot of the photograph with all the Basic panel adjustments you made. 
Name the snapshot Basics and click Create.

7 Leave the photograph open for the next section.
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Fine-tuning contrast in the Tone Curve panel
After you’ve made global adjustments in the Basic panel, if you need to make 
more targeted adjustments to contrast and brightness, you can do so in the 
Tone Curve panel. 

1 DSC0149.dng (the photograph of the rooftops in Paris) should be open in 
the Develop module with all the Basic panel adjustments you added to it in 
preceding sections. If you made a snapshot you named Basics, as suggested at 
the end of the last section, click that snapshot in the Snapshots panel.

2 Click the header on the Tone Curve panel to  
open that panel to its default parametric tone 
curve view.

The parametric Tone Curve panel offers four 
sliders that you can use to adjust the four regions 
of the curve: Highlights, Lights, Darks, and 
Shadows. If your Tone Curve panel doesn’t look 
like this, click the Point Curve icon  at the 
bottom right of the Tone Curve panel.

3 Click the Targeted Adjustment tool (the TAT)  
at the top left of the tone curve panel to activate 
the TAT .

The TAT allows you to make adjustments to targeted tones by dragging directly 
on the photograph.

4 With the TAT activated, go to the photograph in the work area and drag a dark 
part of the building down slightly. 

Dragging down with the TAT moves the corresponding part of the curve down, 
darkening those tones throughout the image.

The light gray overlay on either side of the curve indicates the tonal region that 
is most affected by this move.
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5 With the TAT, drag a bright part of the building up slightly. 

Dragging up with the TAT moves the corresponding region of the curve up, 
lightening those tones throughout the image.

6 Double-click the Region label above the sliders to return all the sliders in the 
parametric Tone Curve panel to their defaults of 0.

To return an individual region slider to its default, double-click the label or 
control on that slider. 

7 Drag the Shadows slider in the Tone Curve  
panel to the left to make the darkest tones in 
the photograph darker. The effect is similar to 
that of dragging the Blacks slider in the Basic 
panel to the left.

Dragging any of the four region sliders is 
another way to make a targeted adjustment in 
the parametric Tone Curve panel. 

Hovering over a slider displays a gray overlay 
on the curve that tells you which part of the 
curve is most affected by that slider.

8 Click the Point Curve icon at the bottom right  
of the parametric Tone Curve panel to switch 
to another view of this panel—the point 
curve view.

In point curve view, you can zero in more 
closely on particular tones by clicking directly 
on the curve to add and drag points. This 
makes point curve view more focused, but also 
more complex to use.

P Note: All the curves 
you create in either 
view of the Tone Curve 
panel are cumulative. 
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9 Click the Channel menu beneath the point curve and choose Blue to access the 
Blue channel. 

10 In the Blue channel, click the center of the curve and drag up to make 
the photograph more blue overall, or drag down to make the photograph 
more gold. 

One advantage of point curve view is that it gives you access to curves for 
individual Red, Green, and Blue color channels. You can use these color curves 
as color correction tools, as you did here. The color channels are also handy for 
making custom split-tones, by dragging the shadow area of a color curve in one 
direction and the highlight area in the opposite direction.

11 Choose RGB in the Channel menu to return that menu to its default.

12 Double-click the Point Curve label at the bottom left of the panel to return all 
curves you made in point curve view to their defaults.

13 Click the Point Curve icon at the bottom right of the panel to return the Tone 
Curve panel to parametric view.

14 Toggle the panel switch  on the left side of the Tone Curve panel header to 
compare the Before view (with no Tone Curve panel adjustments) with the 
After view (with your current Tone Curve panel adjustment). 

If there were multiple parametric curves and point curves still in effect, the 
panel switch would toggle all of them together.

15 Click the Plus icon (+) on the right side of the Snapshots panel to capture a 
snapshot of the photograph with your Basic panel adjustments and your tone 
curve adjustment. Name the snapshot Tone Curve and click Create.

16 Leave the photograph open for the next section.



ADOBE LIGHTROOM AND PHOTOSHOP FOR PHOTOGRAPHERS CLASSROOM IN A BOOK 157

Fine-tuning color in the HSL panel
The Develop module panel labeled HSL/Color/B&W (the HSL panel) offers con-
trols for adjusting ranges of colors wherever those colors occur in an image. You 
can use these controls to adjust the hue, saturation, and lightness of particular 
color ranges.

1 DSC0149.dng (the photograph of the rooftops in Paris) should be open with 
all the adjustments you’ve made to it to this point. If you made a snapshot 
you named Tone Curve, as suggested at the end of the last section, click that 
snapshot in the Snapshots panel now.

2 Click the HSL label (not the Color or B&W label) on the header of the HSL 
panel. Then click the Saturation tab at the top of the panel.

3 Click the Targeted Adjustment tool (the TAT)  at the top left of the HSL 
panel to activate the tool .

The TAT allows you to make adjustments to targeted colors by dragging directly 
on the image.

4 With the TAT, drag down in a saturated blue area of the sky in the photograph. 

Dragging down with the TAT decreases saturation in the range of colors that 
corresponds to the color under your cursor. Dragging up would increase 
saturation in those colors.

The Blue slider in the Saturation tab of the HSL panel moves to the left and the 
blues across the photograph become less saturated.

5 Click the Luminance tab, which offers the same color range sliders as the 
Saturation tab, except that these sliders affect the brightness of colors.

6 With the TAT still active, drag down slightly in the blue sky in the photograph 
to darken the blues. 

Dragging up would lighten the blues.

P Note: The HSL panel 
is useful for converting 
photographs from color 
to black and white too. 
Click the B&W label in 
the panel header. Then 
use the color range 
sliders to fine-tune the 
conversion of individual 
colors to black and 
white brightness values. 
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7 Drag down in a light orange area of the  
buildings in the photograph to darken the 
corresponding colors across the photograph.

Notice that the Orange and Yellow sliders 
moved to the left in the illustration. That 
indicates that there was more than one color 
under the TAT cursor when this move was 
made. One advantage of using the TAT to 
make adjustments directly on the image, rather than dragging sliders in the HSL 
panel, is that the TAT knows exactly which color ranges are involved and can 
drag more than one slider to correspond to the colors under your cursor.

E Tip: Using the TAT and dragging sliders are not the only ways to set controls in the HSL panel. 
You can type a value into the field to the right of a slider. Or you can click a slider label and use the 
Plus (+) and Minus (–) keys on your keyboard (along with modifier keys described earlier in “Working 
with the sliders”) to change a slider value in increments.

8 Click the Hue tab in the HSL panel, which you can use to change the hue of 
colors in a photograph.

9 Drag the Orange slider to the left, toward red. This makes orange hues across 
the photograph (including those in the buildings, the chimneys, and the 
smokestacks) more red-orange as opposed to yellow-orange.

The Hue tab of the HSL panel has a TAT too. You might use this TAT to make a 
blue sky more purple or aqua in hue.

10 Toggle the panel switch on the left side of the HSL/Color/B&W panel header to 
compare the Before view (without HSL adjustments) with the After view (with 
all the current HSL adjustments).

11 To compare the photograph with all adjustments you’ve made to this point 
to the original uncorrected photograph, press the Backslash (\) key on your 
keyboard, or toggle the Y key to see Before and After views. Some of the 
adjustments applied so far have been subtle, but their cumulative effect 
is significant.
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12 Click the Plus icon (+) on the right side of the Snapshots panel to capture 
a snapshot of the photograph with your Basic, Tone Curve, and HSL panel 
adjustments. Name the snapshot HSL and click Create.

You’ll come back to this photograph in this state to make further adjustments later 
in this lesson. In the meantime, you’ll switch files for the next example, in which 
you’ll reduce digital noise and perform initial sharpening on a photograph.

Reducing noise in the Detail panel
The Develop module has powerful controls for reducing the noise that is inherent 
in a digital capture. Digital noise is most apparent in photographs shot with a high 
ISO and in shadow areas of a photograph. 

1 If the Filmstrip is not open in the Develop module, press F6 (or fn-F6) on the 
keyboard. In the Filmstrip, select P1050905.dng (a photograph of garden rakes), 
which was shot at ISO 400.
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2 Click the photograph to zoom in to 1:1 view. Then drag to pan to an area of the 
photograph that displays some grainy digital noise. 

The 1:1 view is the only zoom level at which you can accurately evaluate digital 
noise and sharpening. However, some of the illustrations in this lesson are 
zoomed to 2:1 view to ensure that the effects of noise and sharpening are visible 
in this book.

3 Click the header of the Detail panel in the Develop module to open that panel.

4 If your Detail panel does not display a preview  
area, click the triangle to the right of the 
Sharpening label at the top of the Detail panel 
to reveal a small 1:1 preview.

5 In the Detail panel’s 1:1 preview, drag to an 
area of the photograph that displays some 
grainy noise. 

Alternatively, click the square icon to the left of the 1:1 preview in the Detail 
panel; then click a grainy area in the photograph to direct the 1:1 preview to 
that spot.

P Note: If you do 
not zoom to 1:1 view 
before opening the 
Detail panel, when you 
do open that panel, it 
will display a warning 
icon (!) to the left of 
the Sharpening label 
cautioning you to 
zoom to 100% or larger. 
Clicking that warning 
icon will zoom the 
photograph to 1:1 view.
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6 In the Noise Reduction section of the Detail  
panel, drag the Color slider to the left to 0. 

This disables color noise reduction, revealing 
a significant amount of color noise in the 
photograph. 

7 Double-click the Color label to return the 
Color slider to its default of 25. 

This hides the color noise in the image, 
although there is still some grayscale 
luminance noise.

Three of the sliders in the Noise Reduction 
section address color noise. Dragging 
the Color slider to the right increases the 
amount of color noise reduction, but also 
can cause a loss of edge detail. In some 
images, dragging the color Detail slider to 
the right preserves some of that detail, but 
the effect of this slider may not be noticeable 
unless there is a lot of color noise in the photograph. If you have larger areas 
of mottled color too, dragging the Smoothness slider to the right sometimes 
reduces those artifacts. For this exercise, leave the color Detail and Smoothness 
sliders at their default values of 50.

8 In the Noise Reduction section, drag the  
Luminance slider to the right to reduce 
luminance noise, the grainy grayscale noise 
that is visible in shadow areas of this 
photograph.

Increasing the Luminance slider reduces 
noise by blurring the image slightly. Too 
much luminance noise reduction can give a 
photograph an artificially smooth look. Your 
goal when setting the Luminance slider is to 
reduce noise to an acceptable level without 
blurring the image so much that it looks artificial.

The purpose of the Detail and Contrast sliders under the Luminance slider 
is to compensate for the softening effects of reducing luminance noise. The 
luminance Detail slider acts as a threshold. The lower the value for this slider, 
the more details are softened. In some images, increasing the Detail slider can 
bring back some detail, and increasing the Contrast slider can bring back some 
edge contrast lost by reducing luminance noise. Leave these sliders at their 
defaults of 50 and 0, respectively, for this exercise.
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9 Still at 1:1 view, toggle the panel switch on the left side of the Detail panel 
header to compare the Before view (with default noise reduction) with the After 
view (with your noise reduction adjustments).

10 Leave the photograph open for the next section. 

Capture sharpening in the Detail panel
The purpose of sharpening in the Develop module’s Detail panel is to compen-
sate for the softness that is inherent in digital capture. This initial sharpening is 
sometimes called capture sharpening. You’ll probably sharpen again to prepare a 
photograph for output—either in Lightroom’s Export dialog, Lightroom’s output 
modules, or Photoshop. And you may do some creative sharpening along the way 
too. So be careful not to oversharpen now in the Detail panel.

1 P1050905.dng (the photograph of garden rakes) should still be open with the 
noise reduction adjustments you applied in the previous section, and the image 
should still be zoomed to 1:1 view, which is critical when sharpening.

2 Pan to an area of the image that displays detail.

3 Drag the Amount slider to the right of its default  
of 25 to increase the amount of sharpening.

The Amount slider determines the strength 
of the sharpening effect. Sharpening is 
accomplished by increasing contrast at image edges. The higher the amount, the 
more edge contrast is introduced. 

4 Drag the Radius slider to the left of its  
default of 1.0 to decrease the size of the 
sharpening halos. 

Radius determines the width of the sharpening 
effect at image edges (the halos). If a photograph has lots of detail, the ideal 
setting for the Radius slider is usually lower than it would be for a portrait or 
other photograph that has less detail you want to sharpen.

E Tip: The Amount 
and Radius sliders 
affect one another. 
So it’s common to 
move back and forth 
between these sliders 
as you set their values, 
evaluating the results 
in the 1:1 previews in 
the work area and in the 
Detail panel.



ADOBE LIGHTROOM AND PHOTOSHOP FOR PHOTOGRAPHERS CLASSROOM IN A BOOK 163

5 Leave the Detail slider at its default of 25 to control detail sharpening.

Alt/Option-click the control on the Detail slider to display a grayscale version 
of the image that shows you which image edges are being sharpened (the light 
gray edges). Dragging the Detail slider further to the right would sharpen digital 
noise in this image, which is usually something to avoid.

6 Hold the Alt/Option key as you drag the Masking slider to the right to protect 
parts of the photograph from sharpening.

This displays a mask in which the areas protected from sharpening appear in 
black as you drag the Masking slider. The Masking function is useful to protect 
non-edges from sharpening—like a model’s skin in a portrait, a clear sky in a 
landscape, or digital noise. 

7 For Before and After views of your sharpening settings, double-click the 
Sharpening label in the Detail panel to see the Before view, with default 
sharpening settings; then press Ctrl-Z/Command-Z to undo and see the After 
view, with the sharpening settings you chose.

This comparison leaves your noise reduction settings in place in both the before 
and after states. 

Next, you’ll apply what you’ve learned about noise reduction and sharpening to 
the photograph of the Paris rooftops you last worked with in the section “Fine-
tuning color in the HSL panel.”
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8 If the Filmstrip is not open at the bottom of the Develop module, press F6 (or 
fn-F6) on the keyboard. In the Filmstrip, select DSC0149.dng (the photograph 
of the Paris rooftops).

9 Make sure the adjustments for DSC0149.dng are as they were at the end of the 
section “Fine-tuning color in the HSL panel.” If you created an HSL snapshot to 
record your last adjustments to this image, as suggested at the end of that HSL 
section, click that snapshot in your Snapshots panel now.

10 Try setting the controls in the Detail panel on your own for this photograph, 
using what you learned in this lesson about sharpening and noise reduction. 
The following illustration suggests some sharpening and noise reduction 
settings to try.

11 Click the Plus icon (+) on the right side of the Snapshots panel to capture a 
snapshot of DSC0149.dng with your Basic, Tone Curve, HSL, and Detail panel 
adjustments. Name the snapshot Detail and click Create.

12 Leave this photograph open for the next section.

Retouching with the Spot Removal tool
The Spot Removal tool is useful for hiding circular spots, like dust spots or blem-
ishes, and also for removing some non-circular content from a scene.

1 DSC0149.dng (the photograph of the rooftops in Paris) should be open with all 
the adjustments you’ve made to it to this point. In the Snapshots panel, click the 
Detail snapshot you made at the end of the previous section.

2 Select the Spot Removal tool in the tool strip,  
which is beneath the Histogram panel in the 
column on the right side of the Develop module.

A panel of Spot Removal controls (the Spot 
Removal tool panel) drops down beneath the 
tool strip. 

E Tip: Lightroom 
comes with some 
sharpening presets 
that you can use as 
a starting place for 
capture sharpening. 
When you’re sharpening 
an image that has lots 
of detail, in the Presets 
panel choose Lightroom 
General Presets > 
Sharpen – Scenic. When 
you’re sharpening a 
portrait or some other 
low-frequency image, 
choose Lightroom 
General Presets > 
Sharpen – Faces. Then 
fine-tune the resulting 
sharpening values in 
the Detail panel.
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3 If the Develop module toolbar isn’t showing at the bottom of your screen, press 
T on your keyboard.

4 In the toolbar at the bottom of the Develop module, check the Visualize Spots 
check box. This displays a mask on the photograph in which spots appear as 
white or gray dots.

The Visualize Spots feature is useful for revealing spots caused by dust on a lens, 
sensor, or scanner that you might not have noticed in the photograph.

You can control the sensitivity of the Visualize Spots feature by dragging the 
Visualize Spots slider in the toolbar to the right or left.

5 To zoom in to the photograph, hold the spacebar on the keyboard and click 
the photograph. Release the spacebar and drag to move to a spot you want 
to remove.

P Note: Zooming in or out when you’re working with a local adjustment tool requires that you 
hold the spacebar as you click the photograph. When a local adjustment tool is not selected, 
simply clicking the photograph zooms in and out.



166 LESSON 4 Processing Photos in Lightroom’s Develop Module

6 Move the cursor over a dust spot in the photograph. Size the cursor so that it is 
slightly bigger than the dust spot by pressing the Left Bracket key ([) to decrease 
cursor size or the Right Bracket key (]) to increase cursor size. 

7 Click the dust spot to remove it from view. 

The Spot Removal tool samples content from a 
nearby source area in the photograph to create a 
patch to hide the dust spot. Two circles appear 
in the image. The circle with the Plus icon (the 
destination circle) represents the patch that is hiding the spot; the empty circle 
(the source circle) represents the area from which the patch was sampled.

8 Uncheck the Visualize Spots check box in the toolbar to return to regular view, 
where you’ll no longer see this dust spot.

You can remove spots in either the regular view or the Visualize Spots view. 
One approach is to switch back and forth between views as you work, by 
checking and unchecking the Visualize Spots check box.

In either view, when you move your cursor off the photograph in the center 
work area, the circles disappear from view, because by default the Tool Overlay 
menu in the toolbar is set to Auto. You can change that behavior to Always, 
Never, or Selected (to view just a selected patch).

9 If you don’t like the appearance of a patch, click its destination circle to select 
that patch. Then try one or more of these options:

• To sample from a different location, hover over the source circle to change 
the cursor to a Hand tool, and drag the source circle to a different location. 

• To resize the patch, hover over either circle to change the cursor to a double-
pointed arrow, and drag out to increase or drag in to decrease the size of the 
circles. Or drag the Size slider in the Spot Removal panel. 

• To blend the patch with the surroundings, make sure the Heal option, rather 
than the Clone option, is selected in the Spot Removal tool panel.

• To soften the edge of the patch, drag the Feather slider in the Spot Removal 
tool panel to the right. You can reset this slider and any of the sliders in the 
Spot Removal tool panel to its default value by double-clicking the slider 
label or control.

• To make the patch less opaque, drag the Opacity slider in the Spot Removal 
tool panel to the left.

• To remove the selected patch, press the Delete/Backspace key on the 
keyboard. (If you want to remove all Spot Removal tool patches, click the 
Reset label at the bottom right of the Spot Removal tool panel.)

E Tip: If you have 
lots of spots to remove 
that are close together, 
you may find it more 
efficient to accomplish 
that in Photoshop, 
using Photoshop’s Spot 
Healing Brush tool or 
Healing Brush tool. 

E Tip: To page 
through a photograph 
to inspect it for spots, 
press the Home key on 
your keyboard to start 
at the upper-left corner 
of the photograph. 
Press the Page Down 
button on the keyboard 
to page through the 
photograph from top to 
bottom in a column-like 
pattern.
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Syncing spot removal
If a spot of dust on your camera lens or sensor appears in multiple photographs, 
you can quickly remove it from multiple photographs at once using Lightroom’s 
Sync feature.

1 Use the Spot Removal tool to hide the dust spot on one photograph.

2 With that photograph selected, in the Develop module Filmstrip Ctrl-click/
Command-click thumbnails of other photographs with the same dust spot. 
Make sure that the photograph you corrected is the most selected thumbnail 
(the one with the lightest thumbnail frame in the Filmstrip).

3 Click the Sync button at the bottom of the right panel column in the Develop 
module. If that button reads AutoSync, click the panel switch just to the left of 
the button to change it to read Sync.

4 In the Synchronize Settings dialog, click Uncheck All. Then check the Spot 
Removal and Process Version check boxes. Click Synchronize to automatically 
hide the spot on all selected photographs.

5 If the result needs fine-tuning on any of the affected photographs, open that 
photograph in the Develop module for further editing.

10 Lightroom’s Spot Removal tool can also hide non-circular content. Zoom and 
pan to locate content you want to hide—like one of the railings at the top right 
of this photograph.

11 Size the cursor so it is just a bit larger than the height of the railing, select the 
Clone option in the Spot Removal panel (to avoid the risk that the blending 
behavior of the Heal option will smudge the ends of the patch), and drag across 
the railing in the photograph.

12 Toggle the panel switch for the Spot Removal tool, which is at the bottom left 
of the Spot Removal panel. 

Toggling the panel switch gives you Before and After views of all the circular 
and non-circular corrections you made with the Spot Removal tool.

13 To close the Spot Removal panel, click the Close label at the bottom right of 
that panel.

E Tip: If you have 
more complex content 
to remove, remember 
that you can hand 
off a photograph 
from Lightroom 
to Photoshop to 
take advantage of 
Photoshop’s full-
featured retouching 
tools. 
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14 Click the Plus icon (+) on the right side of the Snapshots panel to capture a 
snapshot of DSC0149.dng with all your global adjustments and your Spot 
Removal corrections. Name the snapshot Spot Removal and click Create.

15 Leave this photograph open for the next section.

Making lens corrections
In the Develop module’s Lens Corrections panel you can adjust for a variety of 
issues related to your camera lens, including lens distortion, lens vignetting, chro-
matic aberration, and perspective problems.

Applying a lens profile

Lightroom uses profiles of camera lenses to correct for lens-related geometric 
distortions and vignetting.

1 DSC0149.dng (the photograph of the rooftops in Paris) should be open with all 
the adjustments you’ve made to it to this point. In the Snapshots panel, click the 
Spot Removal snapshot you made at the end of the previous section.

2 Click the header on the Lens Corrections panel to open that panel, and click the 
Basic tab in the Lens Corrections panel, if that tab is not already open.

3 Check the Enable Profile Corrections check box.  
In many cases, this automatically applies a lens 
profile for the lens with which the photograph 
was shot and automatically corrects geometric 
distortion (pincushioning or barrel distortion) 
and vignetting (dark corners) in the photograph. 

If checking Enable Profile Corrections does not  
alter the photograph, it could be that 
Lightroom did not find the lens profile 
automatically. In that case, click the Profile tab 
in the Lens Corrections panel and use the Lens 
Profile menus there to choose the make, model, 
and profile manually for the lens with which 
the photograph was captured. 
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Adobe has created lens profiles for many  
popular lenses, but if you have a new or 
unusual lens it’s possible Adobe has not yet 
profiled that lens. In that case, you could look 
into making a lens profile yourself, but the 
simpler approach is to use the sliders in the 
Manual tab of the Lens Corrections panel to 
fix geometric distortion and vignetting 
manually.

If you shoot with a mirrorless camera 
(sometimes called a Micro Four Thirds camera), the camera may have 
compensated for lens issues by embedding lens correction instructions into the 
metadata of your raw files. Those corrections may be applied when Lightroom 
initially converts the raw files, rather than through a lens profile invoked in the 
Lens Corrections panel.

4 Leave this photograph open for the next section.

Removing chromatic aberration

Chromatic aberration is a lens-related anomaly that can cause unwanted color 
to appear along image edges. Lightroom can remove some chromatic aberration 
automatically.

1 With DSC0149.dng open, zoom to 1:1 view  
and pan to an edge with visible color 
fringing. Notice the magenta color along 
the edge of the chimney and the green color 
along the shadows on the window structure.

2 Click the Basic tab in the Lens Corrections 
panel if the Basic tab is not already open.

3 In the Basic tab, check the Remove 
Chromatic Aberration check box. 

The magenta and green lines in the preceding  
illustration are now barely visible in the photograph.

4 Leave this photograph open for the next section.

P Note: If you see 
purple or green fringing 
at high-contrast edges 
after checking the 
Remove Chromatic 
Aberration check box, 
try using the Defringe 
controls in the Color tab 
of the Lens Corrections 
panel to remove the 
fringing.
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Correcting perspective with Upright

The Upright feature in the Lens Corrections panel offers automatic corrections for 
some perspective problems related to the angle at which a photograph was shot, 
including leveling a crooked image and reducing keystoning (vertical distortion) in 
shots of buildings. The Upright feature was introduced in Lightroom 5.

1 With DSC0149.dng open, click the Basic tab in the Lens Corrections panel if it 
is not already open.

2 With the Enable Profile Corrections check box checked in the Basic tab, click 
each of the four Upright buttons—Level, Vertical, Full, and Auto—in turn to try 
them out on the photograph. This is usually the best way to approach applying 
Upright, because results can vary from image to image.

• The Level option tries to straighten or level a photograph that is crooked on 
the horizontal or vertical axis.
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• The Vertical option not only levels a photograph but also tries to correct for 
converging vertical lines—like those that make buildings shot from street 
level appear to be leaning back (keystoning).

In this case, the Vertical option makes such an extreme correction that white 
areas of the canvas are left showing on two sides of the adjusted image. 

When an Upright correction reveals canvas around an image, you have 
several options: You can try checking the Constrain Crop check box in the 
Basic tab, although this option may eliminate more content than you would 
like in some photographs. If applying the Upright correction pushed some of 
the photograph off the canvas, you can use the Scale slider in the Manual tab 
of the Lens Corrections panel to reduce scale until all the photograph is back 
in view; then crop the image manually using Lightroom’s Crop Overlay tool 
with the lock icon unlocked for maximum flexibility. Or hand the image off 
to Photoshop, where you can crop the image with Photoshop’s Crop tool or 
try to fill the white edges using Photoshop’s Content-Aware Fill feature. 
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• The Full option tries to fix leveling, vertical perspective, and horizontal 
perspective. This option often delivers the most extreme results, as is the 
case with this photograph.
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• The Auto option is often the best choice, as it is in this case. This option 
attempts to level an image and fix perspective problems, while maintaining a 
natural look. Leave this photograph with the Auto option applied.

3 Toggle the panel switch on the left side of the Lens Corrections panel header to 
compare the Before view (with no lens correction adjustments) with the After 
view (with the current lens correction adjustments).

4 Click the Plus icon (+) on the right side of the Snapshots panel to capture a 
snapshot of DSC0149.dng with all your global adjustments, your Spot Removal 
corrections, and your lens corrections. Name the snapshot Lens and click Create.

5 Leave this photograph open for the next section.

Making local adjustments
Most of the adjustments you’ve made so far are global adjustments—adjustments 
that affect the entire photograph. Often you’ll want to make local adjustments 
too—adjustments that affect just part of a photograph. Photoshop has lots of 
features for making local adjustments, like dodge and burn tools, selections, and 
masks. Lightroom has only a few local adjustment tools, but they are often quite 
useful. Before you hand a file off to Photoshop for local adjustments, consider what 

E Tip: After you make 
an Upright correction, 
you can fine-tune the 
results using the sliders 
in the Manual tab of the 
Lens Corrections panel.
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you can accomplish in Lightroom with the Graduated Filter tool, the Radial Filter 
tool, and the Adjustment Brush tool. 

These three Lightroom local adjustment tools have a lot in common. They all work 
by creating a mask that limits the area affected by adjustments. They all offer the 
same list of adjustments, which you can apply individually or in combination. 
That list of adjustments includes adjustments that are also in the Basic panel—
Temperature, Tint, Exposure, Contrast, Highlights, Shadows, Clarity, Saturation—
plus Sharpness, Noise, Moire, Defringe, and Color tint.

Working with the Graduated Filter tool

With the Graduated Filter tool you can apply adjustments to part of a photograph 
in a gradient pattern. In this exercise you’ll apply two gradient filters with different 
combinations of adjustments to get different effects on the sky and the buildings.

1 With DSC0149.dng still open in the Develop  
module, select the Graduated Filter tool in the 
tool strip beneath the Histogram panel.

The Graduated Filter panel drops down from 
the tool strip.

2 In the Graduated Filter panel, double-click the 
Effect label at the top left of the sliders to set all 
the sliders to their defaults of 0.

The sliders for all the local adjustment tools are 
sticky, so it’s important to reset them. Doing 
that all at once is most efficient. To reset an 
individual slider to its default, double-click the 
slider label or control. 

3 Drag the Exposure slider all the way to the left.

Setting one or more sliders before you create a graduated filter loads the 
Graduated Filter tool with those settings so that they will be applied as you 
create the next graduated filter. This negative exposure setting is just a way to 
help you see the gradient you’ll create in the next step.

4 Click the upper-left corner of the photograph and drag toward the lower-right 
corner, stopping near center of the photograph so that this graduated filter 
covers just the sky.

This creates a mask in a gradient pattern over the sky. The gradient mask defines 
where the Exposure value and any additional parameters you set in the future 
will be applied. 
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You can create multiple graduated filters. Each filter will be represented by a 
separate pin in the photograph. To select a graduated filter, click its pin. When 
a particular graduated filter is selected, its pin turns black. All the pins will 
disappear from view when you move your cursor off the photograph in the 
center work area, because by default the Show Edit Pins menu in the toolbar is 
set to Auto.

5 To reposition this graduated filter, drag its black pin. To rotate the graduated 
filter, drag its center line clockwise or counterclockwise slightly. 

The three white lines on a graduated filter represent the strength of the 
parameters it applies: 100%, fading through 50%, and then down to 0%. You can 
contract or extend the filter’s gradient by dragging either of the outside white 
lines toward or away from the center line. 

6 With the filter’s pin selected in the photograph, change the settings for this filter 
in the Graduated Filter panel. Drag the Exposure slider so it is slightly to the left 
of its default of 0, drag the Temperature slider to the left of its default of 0, and 
drag the Saturation slider slightly to the left of its default of 0. 
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These changes are applied to the selected graduated filter, making the sky 
slightly darker and more blue. 

7 To add another graduated filter, click the New label at the top right of the 
Graduated Filter panel.

This deselects the first pin, which changes to white.

8 Double-click the Effect label in the panel to  
reset all the sliders in the Graduated Filter panel 
to their defaults of 0.

9 Drag a new graduated filter from the lower-
right corner up toward the upper-left corner, 
stopping near the top of the buildings, so that 
this filter covers most of the buildings. The two 
graduated filters can overlap.

This time the graduated filter was not preloaded 
with settings, to demonstrate that you have the 
option to wait to set parameters until after you 
create a graduated filter. The same is true of the 
other local adjustment tools—the Radial Filter tool and the Adjustment Brush tool.

E Tip: You can save 
this combination 
of local adjustment 
settings as a preset 
to apply to other 
photographs. Click 
the Effect menu at the 
top of the drop-down 
panel, and choose 
Save Current Settings 
as New Preset. Name 
the preset and click 
Create. When you want 
to access these settings 
for future use with the 
Graduated Filter tool, 
the Radial Filter tool, or 
the Adjustment Brush 
tool, select this preset 
from the Effect menu in 
the drop-down panel 
for that tool.
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10 With the pin for the second graduated filter selected in the photograph, go 
to the Graduated Filter panel and drag the Temperature slider to the right to 
warm up the color of the building, drag the Shadows slider to the right to open 
up shadow areas in the building, and drag the Clarity slider to the right to 
emphasize the details on the building facade.

11 Toggle the panel switch for the Graduated Filter tool, which is at the bottom left 
of the Graduated Filter panel. 

Toggling the panel switch gives you Before and After views of all the graduated 
filters you added. To see Before and After views of just one graduated filter, 
select its pin in the photograph and double-click the Effect label in the 
Graduated Filter panel (the Before view). Then press Ctrl-Z/Command-Z to 
undo (the After view).

12 To close the Graduated Filter panel, click the Close label at the bottom right of 
the Graduated Filter panel or click the Graduated Filter icon in the tool strip.

13 Click the Plus icon (+) on the right side of the Snapshots panel to capture a 
snapshot of DSC0149.dng with all your global adjustments, your Spot Removal 
corrections, your lens corrections, and your graduated filters. Name the 
snapshot Graduated and click Create.

14 Leave this photograph open for the next section.

E Tip: To remove an 
individual graduated 
filter, select its pin 
and press the Delete/
Backspace key on the 
keyboard. To remove 
all graduated filters, 
click the Reset label 
at the bottom of the 
Graduated Filter panel. 
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Using the Adjustment Brush tool

The Adjustment Brush tool works much like the Graduated Filter tool. The two 
tools apply the same adjustments, individually or in combination, to local areas of a 
photograph that are defined by masks behind the scene. The difference is that with 
the Adjustment Brush tool you paint the adjustments where you want them. Many 
of the mechanics of working with the Graduated Filter tool apply to the Adjustment 
Brush tool also, so refer to the preceding section “Working with the Graduated 
Filter tool” for more details.

1 With DSC0149.dng (the photograph of Paris  
rooftops) still open in the Develop module, 
select the Adjustment Brush tool in the tool 
strip beneath the Histogram panel.

The Adjustment Brush panel drops down from 
the tool strip. The Effect section of the panel 
offers the same adjustments as the Graduated 
Filter panel. The Brush section contains brush 
options for the Adjustment Brush tool.

2 Double-click the Effect label near the top left 
of the Adjustment Brush panel to reset all the 
Effect sliders to their defaults of 0.

3 Choose brush options in the Brush section of 
the Adjustment Brush panel:

• Use the Size slider to set the size of the brush. 

Alternatively, after you’ve created an adjustment brush, size the selected brush 
by pressing the Right Bracket (]) and Left Bracket ([) keys on the keyboard. 

• Use the Feather slider to set the softness of the brush. 

Alternatively, after you’ve created an adjustment brush, set the feather 
value of the selected brush by pressing the Shift-Left Bracket ([) to decrease 
feathering or Shift-Right Bracket (]) to increase feathering. 

The default value of the Feather slider is 100 (maximum softness). To reset 
this slider to its default, double-click the slider label or control.

• Use the Flow slider to set the rate at which adjustments are applied. 

When the Flow slider is decreased, the brush acts like an airbrush, building 
up the opacity of adjustments over multiple strokes. 
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• Use the Density slider to set the maximum opacity of adjustments. 

If you’re not getting the full effect you expect from a brush stroke, it may be 
because the value of the Density slider, the Flow slider, or both is less than 
100. To reset each of those sliders to its default of 100, double-click the slider 
label or control. 

• If you want to adjust a defined area (like an  
object against a solid background), check 
the Auto Mask check box. With this box 
checked, Lightroom will do its best to 
confine the adjustment brush mask to areas 
that match the tone and color under your 
cursor. It does this by continuously sampling as you paint with the 
adjustment brush.

4 If the toolbar is not showing at the bottom of the screen, press T on your 
keyboard. In the toolbar, check the Show Selected Mask Overlay check box.

5 Paint over part of the cloud in the photograph. 

The red overlay is the mask that defines where the adjustments associated with 
this brush will be applied.

If you paint too far and want to erase part of the mask, hold the Alt/Option key 
as you paint. 
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6 Uncheck the Selected Mask Overlay check box in the toolbar to turn off the red 
overlay in the image.

7 With the pin that represents this adjustment brush selected in the image, go to 
the Adjustment Brush panel to set the values of the adjustments for this brush. 
Drag the Clarity slider to the right of its default of 0 and the Highlights slider to 
the left of its default of 0 until you like the result in the image. 

These adjustments are applied to the area affected by this adjustment brush, 
emphasizing cloud detail.

8 To extend the area affected by these adjustments, with the pin for this 
adjustment brush selected, paint over another part of the clouds.

To see where you’ve painted, check and then uncheck the Show Selected Mask 
Overlay check box in the toolbar.

E Tip: There are 
many practical uses 
for local adjustment 
brush corrections, like 
burning and dodging 
(selective darkening 
and lightening), creative 
sharpening, removing 
noise from shadows, 
balancing color, and 
removing color fringe.
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9 To make a change to the adjustments applied by this brush, with the pin for this 
brush selected, go to the Adjustment Brush panel and drag the Exposure slider 
slightly to the left.

You can change or add a setting to an adjustment brush at any time by selecting 
its pin in the image and setting controls in the Adjustment Brush panel. 

10 Toggle the panel switch for the Adjustment Brush tool, which is at the bottom 
left of the Adjustment Brush panel. 

If you’ve created multiple adjustment brushes, this gives you Before and After 
views of all of them. To see Before and After views of just one adjustment 
brush, select its pin in the photograph and double-click the Effect label in the 
Adjustment Brush panel (the Before view). Then press Ctrl-Z/Command-Z to 
undo (the After view).

11 To close the Adjustment Brush panel, click the Close label at the bottom right 
of the Adjustment Brush panel or click the Adjustment Brush icon in the 
tool strip.

12 Click the Plus icon (+) on the right side of the Snapshots panel to capture a 
snapshot of DSC0149.dng with all your adjustments to this point, including 
adjustment brushes. Name the snapshot Brush and click Create.

13 Leave this photograph open for the next section.

P Note: You can add 
multiple adjustment 
brushes to an image, 
each with its own 
settings and pin. To 
add a new brush, click 
the New label at the 
top of the Adjustment 
Brush panel and click 
the image.
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Applying the Radial Filter tool

The Radial Filter tool applies the same adjustments as the Gradient Filter tool and 
Adjustment Brush tool, but in a circular pattern. The Radial Filter tool is useful for 
spotlighting elements in a photograph and for vignetting to draw attention to an 
off-center element.

1 With DSC0149.dng still open, select the  
Radial Filter tool in the tool strip beneath the 
Histogram panel.

The Radial Filter panel drops down from the 
tool strip.

2 Double-click the Effect label near the top left 
of the Radial Filter panel to reset all the Effect 
sliders to their defaults of 0. 

3 Drag the Feather slider in the Radial filter panel 
to 100, if it is not already there. 

This ensures a gradual, soft transition at the 
outside edge of a radial filter. After you create a 
radial filter with a particular Feather value, you 
can still adjust the amount of feather on that 
filter using the Feather slider.

4 Make sure the Invert Mask check box is not checked, which is the default. 

This ensures that adjustments assigned to a radial filter affect the area outside, 
not inside, the radial filter. 

5 Drag the Exposure slider to the left in the Radial Filter panel.

6 In the photograph, position your cursor slightly off-center (over the clouds) and 
drag to the right to create a large radial filter.

The decrease in exposure affects the area outside the radial filter by default, 
creating a subtle vignette effect. 

The purpose of a vignette is to direct the viewer’s attention away from the edges 
of the photograph and toward important content. The advantages of creating 
a vignette with the Radial Filter tool are that a radial filter vignette can be off-
center and it can incorporate any of the adjustments in the Radial Filter panel. 
For example, you could adjust the color temperature or the saturation of the 
vignette instead of just the exposure. (The Post-Crop Vignette feature in the 
Develop module’s Effects panel doesn’t offer these advantages.)

E Tip: To add a radial 
filter that fills the 
image and is centered, 
Ctrl-Alt-double-click/
Command-Option-
double-click in the 
photograph.
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7 With the pin that represents this radial filter selected in the photograph, go to 
the Radial Filter panel and tweak the value of the Exposure slider to your taste, 
making the vignetted corners darker or lighter than they were initially.

8 Reposition and resize the filter to your liking using these techniques:

• Drag from inside the radial filter to move it to a different location on 
the image.

• Hover over a square anchor point on the border of the radial filter. When 
the cursor changes to a double-pointed arrow, drag toward or away from 
the center of the filter to resize the filter.

• Hover outside the border of the radial filter. When the cursor changes to a 
curved arrow, drag to rotate the filter. 

9 Click the New button at the top right of the Radial Filter panel to start creating 
another radial filter.
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10 Position your cursor over the bird  
in the photograph and drag 
outward to create another, 
smaller radial filter around the 
bird. Reposition and resize this 
filter to your liking.

11 With the pin that represents 
the radial filter around the bird 
selected in the photograph, 
check the Invert Mask check box 
near the bottom of the Radial Filter panel. 

This ensures that the adjustments you assign  
to this radial filter will affect that area inside the 
filter rather than outside the filter. This allows 
you to use the Radial Filter tool as a spotlighting 
tool, rather than just another vignetting tool. 

12 In the Radial Filter panel, drag the Exposure and Contrast sliders to the right of 
their defaults of 0.

This increases exposure and contrast inside this radial filter to draw attention to 
the bird.
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13 Create one more radial filter using the same techniques. With Invert Mask still 
checked, create another radial filter over a part of the building to which you’d 
like to add some light. For this radial filter, move the Temperature and Tint 
sliders to the right to warm up the color, set Exposure to the right of its default 
of 0 for brightness, and set Highlights to the left of its default of 0 to retain 
detail in the highlights.

This filter gives the impression of sunlight shining like a subtle spotlight on part 
of the building.

14 Right-click/Control-click the pin of  
the sunlight radial filter and choose 
Duplicate from the pop-up menu.

The duplicate filter is directly on 
top of the original filter, so at first 
the adjustments appear at double 
strength.

15 Drag the selected pin (which is the pin for the  
duplicate filter) to another part of the building to 
add a spot of sunlight there.

16 Reshape the duplicate filter in its new location 
to fit the content there, using the techniques 
covered earlier in this section. With the duplicate 
filter selected, you can also tweak its settings 
in the Radial Filter panel separately from the 
original filter. 
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17 Toggle the panel switch for the Radial Filter tool, which is at the bottom left of 
the Radial Filter panel. 

If you’ve created multiple radial filters, this gives you Before and After views of 
all of them. To see Before and After views of just one radial filter, select its pin 
in the photograph and double-click the Effect label in the Radial Filter panel 
(the Before view). Then press Ctrl-Z/Command-Z to undo (the After view).

18 To close the Radial Filter panel, click the Close label at the bottom right of the 
Radial Filter panel or click the Radial Filter icon in the tool strip.

19 Toggle the Backslash key (\) to compare the current version of the photograph 
(with all the global and local adjustments you made in Lightroom’s Develop 
module) to the original (with no adjustments).

20 Click the Plus icon (+) on the right side of the Snapshots panel to capture a 
snapshot of DSC0149.dng with all your global and local adjustments, including 
radial filters. Name the snapshot Radial and click Create.

21 Leave this photograph open for the next section.
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Saving metadata to files
One way to save metadata to files is to do so manually. 

• With DSC0149.dng still open in the Develop module with all the adjustments 
you added to it during this lesson, choose Photo > Save Metadata to File (or 
press Ctrl-S/Command-S).

Why save metadata to the file? 
Develop adjustments and other metadata changes are recorded in the Lightroom 
catalog by default. Saving metadata to the file saves your changes back to the 
photograph too. This ensures that other applications, like Adobe Bridge and Camera 
Raw, will be able to view the changes you’ve made to the photograph. Saving 
metadata to a file also acts as an insurance policy. It protects you from losing your 
changes if a photograph and its metadata are inadvertently removed from the 
Lightroom catalog.

When you save metadata to a DNG file, the metadata is stored in a special area 
inside the DNG without affecting the image pixels. The same is true when you save 
metadata to a JPEG, TIFF, PSD, or PNG. However, when you save metadata to a 
camera manufacturer’s proprietary raw file, the metadata is stored in a separate 
XMP sidecar file that you must keep with the corresponding raw file. 

When you’re working with a DNG file you have an alternative to the Save Metadata 
to File command. You can choose to select the file in the Library module and 
choose Metadata > Update DNG Previews & Metadata. This saves the metadata to 
the file just like the Save Metadata to File command and also ensures that the JPEG 
preview in the DNG file is updated so other applications can see your changes.

Another way to save metadata to files is to do so automatically to all your 
photographs. 

• To enable the automatic option, choose Lightroom/Edit > Catalog Settings, click 
the Metadata tab, and check the Automatically Write Changes into XMP check 
box. Close the Catalog Settings dialog. 

The upside of the automatic option is that whenever you make an adjustment 
it is saved automatically to the photograph, without you having to do anything 
else to make that happen. The major downside is that continuous, automatic 
saving could possibly interfere with Lightroom’s performance.
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Working with virtual copies
When you want to experiment with different adjustments, or when you need 
different versions of a photograph (like a color version and a black and white), 
virtual copies come in handy.

1 If the Filmstrip is not showing in the Develop module, press F6 (or fn-F6) 
on your keyboard. Select DSC0149.dng in the Filmstrip if it is not already 
selected there.

2 Choose Photo > Create Virtual Copy, or press the keyboard shortcut  
Ctrl-’ (apostrophe)/Command-’ (apostrophe).

This creates a virtual copy of the photograph that appears in the Filmstrip along 
with the original. The virtual copy is identified by the turned-up page icon at its 
bottom left corner. 

A virtual copy is not an actual pixel-based copy that takes up valuable space 
on your computer drive. It is just an alternative set of processing instructions 
stored in the Lightroom catalog. This means you can create and experiment 
with multiple virtual copies of a photograph, each with different adjustments, 
without a lot of overhead.

3 In the Filmstrip, select the virtual copy you just made.

4 Press V on the keyboard to quickly convert the virtual copy to black and white.

Notice that this adjustment does not affect the original of the photograph. You 
are free to make additional virtual copies and try out different adjustments on 
each of them without affecting the original or filling up your drive.

E Tip: You can also 
make virtual copies 
of one or more 
photographs in the 
Library module. 
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Review questions
1 When you adjust a photograph in Lightroom’s Develop module, do your adjustments 

change image pixels in the photograph?

2 If you close Lightroom after making adjustments to a photograph and reopen 
Lightroom a week later, when you open that photograph in the Develop module will 
your previous adjustments be listed in the History panel?

3 Lightroom has many controls for making global adjustments to a photograph. 
When you want to make targeted, local adjustments, do you always have to pass a 
photograph off to Photoshop for that purpose? 

4 What does the Exposure slider do in the current Lightroom process version? 

5 Is there one right way to white balance a photograph?

Review answers
1 No. Adjustments you make to a photograph in Lightroom do not change image pixels. 

Adjustments are recorded as instructions in the Lightroom catalog.

2 Yes. The History panel keeps track of all the adjustments you make to a photograph 
forever, unless you delete history states.

3 No. You can make some local adjustments in Lightroom, using tools like the Graduated 
Filter tool, the Radial Filter tool, and the Adjustment Brush tool. If you need to make 
a more complex local correction, such as one that requires a precise selection, then 
pass the file off to Photoshop, usually after making fundamental global corrections 
in Lightroom.

4 Increasing or decreasing the Exposure slider affects the overall brightness of 
a photograph. The Exposure slider has its primary effect on the midtones in 
a photograph.

5 No. White balancing is subjective. Lightroom’s White Balance controls can neutralize 
a color cast in a photograph, but there are times when a color cast is desirable as a 
way to communicate the mood and message that you, as the photographer, choose 
to convey. 
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D

deleting
keywords, 107
snapshots, 130

derivative files
defined, 33

importing to Lightroom, 58–59
saving JPEG source files as TIFF, 

65–66
Detail panel

adjusting capture sharpening, 
162–164

reducing noise in, 159–162
Develop module, 116–189. See also 

Basic panel
accessing photos in, 121
adjusting capture sharpening, 

162–164
Adjustment Brush tool, 178–181
comparing Before/After views, 

131–133
creating snapshots, 129–130
customizing, 122–123
Filmstrip in, 45
fine-tuning raw files with, 133
global adjustments with Basic panel, 

134
Graduated Filter tool, 174–177
History panel, 130–131, 189
HSL panel, 157–159
interface for, 120–121
Lens Corrections panel, 168–173
lesson files for, 118
order of adjustments in, 137
parametric editing in, 2
photo editing using, 119, 189
preparing panoramic images for 

syncing, 233–235
Radial Filter tool, 182–186
reducing noise in, 159–162
retouching images in, 164–167, 301
shortcuts for, 124
Tone Curve panel, 154–156
toolbar in, 121, 165
tools for local adjustments in,  

173–174, 189
undoing adjustments in, 126–131
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Develop module (continued )
using develop preset in, 62
workflow using, 119–120
working with virtual copies, 188
zooming and panning in, 124–126

develop presets
applying from Quick Develop panel, 81
defined, 62

develop settings, 18
digital cameras. See cameras
DNG (Digital Negative) format

copying vs. converting photos to, 17
importing camera files in, 22
saving metadata to, 119, 187

downloading lesson files, 4–5
dragging/dropping

files between folders, 110–111
image to Photoshop, 206–207

drop shadows
adding layer style with, 344
type, 344, 363

duplicates
effect of Smart Object edits on, 212
making duplicate radial filters, 185
preventing when importing photos, 18
working with virtual copies, 188

dust removal
Lightroom’s Spot Removal tool for, 

164–168
from multiple photographs, 167
Photoshop healing tools for, 166, 167

E

edges
adjusting image, 243
evaluating in Quick Mask mode, 248
feathering, 266
Pen tool for selecting smooth, 

249–250

refining Patch tool, 308
selecting with Magnetic Lasso tool, 247
using Photoshop Refine Edge, 287, 289

Edit In command (Photoshop), 45, 75
Edit Original command (Photoshop), 

53–56, 75, 296
editing. See also global adjustments; local 

adjustments; nondestructive editing; 
retouching in Photoshop

Lightroom’s parametric, 2, 119, 189
linked Smart Objects, 223
pixels in Photoshop, 2
raw files in Photoshop, 46–49
RGB derivative files in Lightroom, 

67–79
undoing/redoing adjustments, 

126–131
using nondestructive cropping, 

339–340
working with virtual copies, 188

Effects panel, 182
Elliptical Marquee tool (Photoshop), 352
emailing Lightroom files, 70
embedded previews, 19
embedded Smart Objects. See also 

Smart Objects
about, 204
icon for, 208
raw files as, 239
using in Photoshop, 204–205, 239

Erase Refinements tool (Photoshop), 292
error messages

mismatched files in Lightroom–
Photoshop editing, 52

missing files, 55, 110, 113
missing RGB profile, 36
moving file on disk, 111

exclamation point (!), 55, 110
expanding Library module panels, 92, 115
exporting Lightroom files, 69–73, 75
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exposure
adjusting in Basic panel, 134,  

142–143, 189
bracketing multiple image, 226

Extend option (Content-Aware Move 
tool), 302

external drives
importing photos from, 16–17, 21
storing photo folders on dedicated, 14

external editors
configuring primary, 26–28
file naming preferences for, 34–35
Photoshop as primary and 

secondary, 29
Photoshop Elements as, 32
selecting additional, 28–31
setting Lightroom preferences for, 

25–31
stacking preference settings for, 33–34

F

feathering layer mask edges, 266
Filename Template Editor

customizing template in, 24–25
setting conventions for external 

editors, 34–35
files. See also derivative files; lesson files; 

raw files; and specific file formats
choosing folders for imported 

camera, 23
copying in DNG format, 17
customizing filename template for, 

24–25
derivative, 33, 58–59, 65–66
formats retaining alpha channels, 262
moving outside Lightroom, 112
moving within Library module, 

110–111
opening multiple Lightroom files in 

Photoshop, 239
preferences for naming, 24–25, 34–35

re-linking missing, 112, 113–114
renaming, 24
saving metadata to, 119, 187
saving Photoshop RGB file to 

Lightroom, 50–51, 55
source, 33, 64
working with proprietary camera, 43

fill
adding mask with black, 281
adding to type, 345–346
changing color with layer of, 250–253
gradient, 253–257, 351
layer masks for every layer of, 252
removing content with content-aware, 

305–306
solarizing, 379

Filmstrip
finding merged HDR images on, 229
hiding/showing, 45
using, 86, 121

Filter Gallery (Photoshop), 364, 369, 376
filtering photographs. See ranking 

photographs
filters. See also Smart Filters; and specific 

filters
applying gradient masks with, 

174–177
artistic, 364
availability of Photoshop, 364
customizing Oil Paint, 369–376
Iris Blur, 323–328, 333
Liquify, 316–322, 333
nondestructive application of, 381
Oil Paint, 371, 374–375
replicating paintings, 376
Solarize, 377–380
sorting photos with Attribute, 95
Tilt-Shift Blur, 328–332, 333
working with radial, 182–186

flags, 93–96, 101–103



388 INDEX

folders
building structure for photos, 14–15
choosing for imported camera files, 23
displayed in Folders panel, 80
downloading LPCIB, 12
dragging/dropping files between, 

110–111
exporting Lightroom files to, 70
importing photos into Lightroom, 15
moving outside Lightroom, 112
re-linking missing, 112
selecting in Folders panel, 115
storing on dedicated drives, 14

Folders panel, 80, 115
foreground color adjustments, 248, 260, 

281, 285
Forward Warp tool (Photoshop), 317, 318
Freeze Mask tool (Photoshop), 317, 318

G

geometric distortion
correcting, 168–169, 258
wide-angle lens and, 236

global adjustments
adjusting raw files in Lightroom, 

258–260
applying develop settings during 

import, 18
defined, 34
making initial changes in 

Lightroom, 193
syncing in Lightroom, 194
using Develop’s Basic panel, 134

Gradient Editor (Photoshop), 256
gradient fill

adding textured, 351
layers of, 253–257

gradient masks, 174–177
Graduated Filter tool (Lightroom), 

174–177
removing filters, 177

repositioning filters, 175
saving local adjustments as preset, 176
selecting when using multiple filters, 

175, 177
Grid view

adding photos to collections in, 100
seeing star ratings in, 96
shortcut for, 84, 115

H

hair selections, 287–296
HDR images. See 32-bit HDR images
Healing Brush tool (Photoshop)

removing content with, 309–311
Spot Healing Brush vs., 333
tips on using, 166

help resources, 8–9
hiding/showing

Develop toolbar, 121, 165
Filmstrip in Develop module, 45
layers and contents, 213–216, 239, 

338, 379
missing Develop panels, 123
Module Picker, 86
toolbar, 83, 115, 121

highlights
adjusting with Whites and Blacks 

sliders, 147–149
clipping, 147–148
recovering, 144–145
specular, 331

Histogram panel
about, 81
evaluating photographs with, 136–137
highlight clipping indicator, 147
shadow clipping indicator, 148–149

History panel, 130–131, 189
HSL panel, 157–159
hue adjustments, 269
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I

icons
chain link, 343
embedded Smart Object, 208
linked Smart Object, 220
question mark, 112
warning, 160

images. See photographs
Import window, 16, 17
importing, 15–25

adding copyright data during, 20
from camera, 22–25
lesson files, 16–17, 21, 41, 42
photographs into folders, 15
photos from drives, 16–17, 21
place in workflow, 15–16
preventing duplicates when, 18
preview options for imported files, 19
Synchronize option for, 66

inverting selections, 245, 260–263, 
282–283

Iris Blur filter (Photoshop), 323–328, 333

J

JPEG files
editing in Lightroom–Photoshop, 

62–66
modifying white balance for, 141
saving, 64
saving as derivative TIFF files, 65–66
TIFF or PSD vs., 29–30, 64

K

keyboard shortcuts
adding full-image, centered radial 

filter, 182
brush size adjustments, 178
cursor size adjustments, 166
cycling through blend modes, 212

Develop module, 124
Develop toolbar, 121, 165
Library toolbar, 83, 115
Loupe and Grid views, 84, 115
opening Lightroom files in Photoshop, 

45, 75
paging through photographs, 166
Photoshop Free Transform tool, 198
selection, 245, 297
slider adjustments using, 134–135
zooming in/out, 166

Keyword List panel, 82
Keywording panel, 82
keywords, 103–110

applying, 18, 105–107
creating, 103–105
searching photographs by, 107–110
using, 103, 105, 106

L

Lasso tool (Photoshop), 281, 287
layer clipping mask, 346–347, 381
layer masks

adding to blurred object, 368
channel selections for creating, 

276–286
color of, 214–215, 216, 239
feathering edges of, 266
fill layer, 252
hiding layer contents with, 213–216, 

239
modifying type shape with, 341–342
moving layers independent of mask, 

275, 343
previewing adjustment, 264
reloading and reusing, 268
replacing dull sky with, 271–276
unlinking layer from, 343, 381
using on adjustment layer, 265–266, 

297



390 INDEX

layer styles, 344
layered composites, 193–204

building in Photoshop, 197–203
making initial Lightroom adjustments, 

193–195
opening Lightroom images as layers, 

196
saving back to Lightroom, 204

layers. See also layered composites
adding grass to foreground with, 

284–285
aligning in Photoshop, 200
applying Liquify filter to, 316
changing selection color with fill, 

250–253
converting to Smart Objects, 197, 338, 

366, 371, 381
copying images with all, 59–62
creating alpha channel from selected, 

279–280
duplicating, 381
flattening when passing file to 

Lightroom, 56, 57
gradient fill, 253–257
hiding contents with layer masks, 

213–216
hiding filtered, 379
importing files into Lightroom with, 

58–59
layer clipping mask, 346–347, 381
moving independent of layer mask, 

381
opening Lightroom images as, 196
selecting objects for Content-Aware 

Move, 302–305
showing/hiding, 338
storing edits on separate, 302
styling, 344
turning selection into, 381
type, 341
unlinking from layer mask, 343, 381

using adjustment, 258–270
viewing inside Blur Gallery dialog, 325

Lens Corrections panel, 168–173
adjustments with, 168
applying lens profiles, 168–169, 

258–259
correcting perspective, 170–173
removing chromatic aberration, 

169, 259
lenses. See also Lens Corrections panel

correcting distortions and vignetting 
of, 168–169, 258

creating lens profiles, 168–169, 
258–259

removing chromatic aberration, 
169, 259

lesson files
combining Lightroom–Photoshop 

photos, 192
creating catalog for, 5–7
Develop module, 118
downloading, 4–5
importing from external drive, 16–17, 

21, 41
Library module, 78
Lightroom–Photoshop roundtrip 

workflow, 42
opening Getting Started, 12
prerequisites for lessons, 8
retouching in Photoshop, 300
selection and masking in Photoshop, 

242
special effects, 336

Levels dialog, 280
Library module, 76–115

applying flags in, 93–96
collapsing panels for, 92, 115
collections in, 98–103
customizing, 92
Filmstrip in, 86
Folders panel, 80
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illustrated, 79
importing standard previews into, 19
information panels of, 81–83
keywords in, 103–110
lesson files for, 78
moving files inside, 110–111
rating photos with stars, 96–98
reviewing thumbnails in, 18
selecting preview in, 88–90
source panels of, 79
switching to other modules, 86
toolbar, 83–86, 115
using, 77
zooming and panning images in, 87

Lightroom. See also Lightroom–
Photoshop roundtrips; preparing 
Lightroom for Photoshop files; and 
specific modules

adjusting Photoshop edits in, 67–79
alternative workflows for Photoshop 

roundtrips, 74
appearance of transparent pixels in, 

220
capture sharpening presets for, 164
catalogs in, 13–14
editing original linked Smart Objects, 

224–225
editing RGB copy with, 56–59
exporting files, 69–73, 75
features of, 2–3
file compatibility with Photoshop, 

36–37
help resources for, 8–9
local adjustments in, 120, 173–174, 

189, 193
making RGB edits without Lightroom 

adjustments, 59–62
opening multiple images as Photoshop 

layers, 196
parametric editing system in, 2, 119, 189
Photoshop features vs., 1–2

process version of, 136
processing multiple photos in, 3, 119
raw file adjustments in, 3, 43–45, 51, 

258–260
rendering mismatched files in, 52
rounding edge of photo in, 354–355
saving Photoshop layered composite 

in, 204
setting external editing preferences, 

25–31
synchronizing spot removal, 167
updating Camera Raw plug-in, 37–38
video editing in, 14
workflow strengths of, 2–3
working with virtual copies, 188

Lightroom–Photoshop roundtrips. 
See also combining Lightroom–
Photoshop photos; preparing 
Lightroom for Photoshop files

adjusting edits in Lightroom, 67–79
alternative workflows for, 74
completing workflow in Lightroom, 67
configuring Photoshop color settings, 

35–36
editing photos in Photoshop, 46–49
editing RGB copies with Lightroom, 

56–59
lesson files for, 42
maximizing compatibility of 

Photoshop files, 36–37
mismatched files in, 52
Photoshop editing for RGB originals, 

53–56, 75
raw file adjustments in Lightroom, 

3, 43–45, 51, 258–260
rendering raw file in Photoshop, 

45–46, 75
saving Photoshop RGB to Lightroom, 

50–51, 55
typical workflow for, 40, 41
using JPEG source files, 62–66
working with RGB files in, 53
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link icon, 220
linked Smart Objects, 218–225

about, 205
creating, 218–219
editing, 223
effect of changes to, 224, 225, 239
saving files containing, 220–221, 222

Liquify filter
applying to layer, 316
changing portrait’s features with, 

316–320
retouching Smart Object with,  

320–322, 333
using as Smart Filter, 320

loading. See opening
local adjustments

Lightroom vs. Photoshop for, 120, 
173–174, 189, 193

Photoshop for selections and masks, 
243

saving and selecting presets for, 176
zooming in/out while making, 165

Loupe view
shortcut for, 84, 115
switching to Before and After views 

from, 131–133
zooming and panning images, 87

luminance noise reduction, 161

M

Magic Wand tool (Photoshop), 260–261
Magnetic Lasso tool (Photoshop), 247
Masking slider (Detail panel), 163
masks. See also layer masks

applying mask overlay to portraits, 
313–315

channel masks, 276–286
cleaning up with Overlay blend mode, 

282
displaying Adjustment Brush tool 

mask overlay, 179–180

gradient masks, 174–177
layer clipping masks, 346–347, 381
Photoshop and Lightroom options 

for, 243
replacing sky using, 271–276
selection cleanup in Quick Mask 

mode, 248
viewing or saving Blur Gallery, 326

Merge to HDR Pro dialog (Photoshop), 
227–229

Merge to Panorama in Photoshop 
command (Lightroom), 236

metadata
copyright, 20, 72
saving to files, 119, 187

Metadata panel, 82–83
minimal previews, 19
missing files

exclamation point indicating, 
55, 110, 113

re-linking, 112, 113–114
Missing Profile warning dialog, 36
Module Picker, 86
moving

files inside Library module, 110–111
folder and files outside Lightroom, 112
images to Photoshop for selection and 

masking, 243
layers unlinked from layer masks, 

275, 343
objects to Photoshop, 302–305
type on path, 357–359, 381

multiple catalogs, using, 14

N

naming
exported Lightroom files, 71
preferences for file, 24–25, 34–35

Navigation panel, 140
New Metadata Preset dialog, 20
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New Smart Object via Copy command 
(Photoshop), 212

noise reduction controls, 159–162
nondestructive editing. See also Smart 

Filters
catalogs for, 13, 119
cropping nondestructively, 339–340
Lightroom’s use of, 119, 189
Photoshop workarounds for, 2

O

objects. See also Smart Objects
isolating in selections, 276–286
moving in images, 302–305
removing from images, 305–306
revealing more detail in selection, 

289–291
Oil Paint filter (Photoshop)

applying, 371, 374–375
customizing effect of, 369

1:1 previews
about, 19
adjusting capture sharpening in, 162
zooming to before opening Detail 

panel, 160
Open as Layers in Photoshop command 

(Lightroom), 196, 337
Open as Smart Object command 

(Lightroom), 218
opening

Detail panel for 1:1 previews, 160
Lightroom images as Photoshop 

layers, 196, 337
Lightroom photos as Photoshop 

Smart Objects, 218
mismatched raw files in Photoshop, 52
raw files in Photoshop, 45, 75
saved selections, 262

output
exporting Lightroom files, 69–73, 75
Lightroom features for, 3

sharpening, 72
types of Lightroom, 70

P

paging through photographs, 166
panels (Lightroom). See also Basic panel; 

Histogram panel
Apply During Import, 18, 20
Channels, 277, 278
collapsing Library module, 92, 115
Detail, 159–164
displaying in Solo mode, 123
displaying missing Develop, 123
Effects, 182
expanding Library module, 80
Folders, 80, 115
Histogram, 81
HSL, 157–159
Keyword List, 82
Keywording, 82
Lens Corrections, 168–173
Metadata, 82–83
Presets, 62, 128, 129
Quick Develop, 62, 81
Tone Curve, 154–156
two keyword, 82
viewing adjustments in Before and 

After views, 135
panning images, 87, 124–126
panoramic images, 233–238
parametric editing, 2, 119, 189
Patch tool (Photoshop), 307–308
path, 353–364

adding type to curved, 355–356
changing size of type on, 360–364
positioning type on, 357–359, 381
using vector shapes and, 353

Path Selection tool (Photoshop), 381
Pen tool (Photoshop), 249–250
perspective corrections, 170–173
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photographs. See also book cover 
composite; duplicates; layered 
composites; 32-bit HDR images

adding watermarks to, 72
applying Liquify Smart Filter to, 

320, 333
applying radial motion blur to, 

365–369
clarity adjustments to, 150–151
clicking frame to select thumbnails, 91
comparing before and after views, 

131–133
converting to black and white, 

51, 54, 157
converting to DNG, 17
copyright metadata for, 20, 72
correcting perspective of, 170–173
cropping HDR, 232
editing workflow with Develop 

module, 119–120
effect of process version on, 136
evaluating before adjusting, 136–137
history states of, 130–131
importing into Lightroom folders, 15
indexing in single catalog, 14
isolating complex objects in, 276–286
keywords for, 18, 105–107
merging into panoramic image, 

233–238
moving to Photoshop for selection 

and masking, 243
opening Lightroom images as layers, 

196
order of adjustments in, 137
organizing in Folders panel, 80
paging through, 166
positioning on layered composite, 200
ranking, 93–98
recovering highlights in, 144–145
resizing, 202, 211

retouching with Spot Removal tool, 
164–167

rounding edges in Lightroom, 
354–355

saving metadata to, 119, 187
searching by keyword, 107–110
sizing exported, 71, 72
solarizing black-and-white, 377–380
storing, 14
stretching parts of, 302
structuring folders for, 14–15
synchronizing, 66
transparent pixels in Lightroom, 220
unlinking new image from original 

Smart Object, 212
working with shadows in, 145–146
working with virtual copies, 188
zooming and panning images, 87

Photomerge dialog (Photoshop), 236–237
Photoshop. See also Lightroom–

Photoshop roundtrips; retouching in 
Photoshop; selections and masking 
in Photoshop

adjusting edited RGB in Lightroom, 
67–79

alternative roundtrip workflows with 
Lightroom, 74

batch processing in, 194
best use with Lightroom, 4
Blur filters in, 323–332
building layered composites in, 

197–203
choosing as external editor, 25–31
combining multiple selection tools, 246
configuring color settings for 

Lightroom use, 35–36
differences between Lightroom and, 

1–2
editing original RGB in, 53–56, 75
editing rendered Lightroom photos, 

46–49
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effect of changes to linked Smart 
Objects, 224, 225, 239

embedded and linked Smart Objects 
in, 204–205, 239

filters in, 364
help resources for, 8–9
inverting selections, 260–263
local adjustments in Lightroom vs., 

120, 173–174, 189, 193
making RGB edits without Lightroom 

adjustments, 59–62
maximizing file compatibility for 

Lightroom, 36–37
moving images to for selection and 

masking, 243
opening Lightroom images as layers 

in, 196, 337
precise selections in, 4, 244
rendering Lightroom raw file in, 

45–46, 75
resetting tool defaults, 260
rulers in, 201–202, 203
saving layered composite to 

Lightroom from, 204
saving RGB file to Lightroom, 

50–51, 55
selection cleanup in Quick Mask 

mode, 248
spot removal in Lightroom vs., 

166, 167
touching up edit in Lightroom, 

372–373
when to make edits in, 120

Photoshop Elements, 32
Photoshop Lightroom. See Lightroom
Polygonal Lasso tool (Photoshop), 

246–247
portraits, 312–322

adjusting first in Lightroom, 312–315
changing features with Liquify, 

316–320

retouching photos converted to Smart 
Objects, 320–322, 333

Post-Crop Vignette feature, 182
preference settings

bit depth, 27–28, 30
compression, 28
external editor, 25–31
file naming, 24–25, 34–35
resolution, 28, 30
stacking, 33–34

preparing Lightroom for Photoshop files
about derivative and sources files, 33
choosing external editor preferences, 

25–31
configuring Photoshop color settings, 

35–36
lesson files needed, 12
maximizing compatibility of 

Photoshop files, 36–37
presets

additional external editor, 31
applying, 128, 129
capture sharpening, 164
copyright metadata, 20
develop, 62
Import, 21
saving and selecting local adjustment, 

176
using for exported files, 73

Presets panel, 62, 128, 129
previews

choosing range of, 90
feathering, 266
1:1, 19, 160, 162
options on Build Previews menu, 

18, 19
selecting in Library module, 88–90
Smart Previews, 13, 18
synchronizing most selected, 88
white balance, 140
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process version, 136
profiles

color, 27, 36
lens, 168–169

PSD files
about, 26
JPEG vs., 29–30, 64
saving raw file as, 75

Pucker tool (Photoshop), 319

Q

question mark icon, 112
Quick Develop panel, 62, 81
Quick Mask mode (Photoshop), 248
Quick Selection tool (Photoshop),  

244–245, 262–263

R

Radial Filter tool (Lightroom), 182–186
adding full-image, centered filter, 182
saving local adjustments as preset, 176
uses for, 182

radial motion blur, 365–369
ranking photographs, 93–98

building Smart Collections, 101–103
color labels for, 97–98
flags for, 93–96
sorting flags, ratings, and labels, 95
star ratings, 96

raw files
adjusting in Lightroom, 3, 43–45, 51, 

258–260
color profiles for, 27
editing first in Develop module, 

119–120
embedding in Photoshop as Smart 

Objects, 204–205, 239
fine-tuning with Develop module, 133
importing proprietary formats in 

DNG, 17

Photoshop editing of, 46–49
rendering in Photoshop, 45–46, 75

re-linking missing files, 112, 113–114
Refine Edge feature (Photoshop), 287, 289
Refine Radius tool (Photoshop), 289–292
reformatting camera memory card, 25
rejecting flagged thumbnails, 93–96
removing. See also dust removal

all history states, 131
areas from selection, 245, 247
chromatic aberration, 169, 259
color labels, 97
content with content-aware fill, 

305–306
graduated filters, 177
objects in photos with Photoshop 

tools, 309–311
Polygonal Lasso selections, 246
star ratings, 96

renaming files, 24
rendering

Lightroom raw file in Camera Raw, 
45–46, 75

mismatched files in Lightroom, 52
repositioning

graduated filters, 175
layers, 338
tilt-shift blur, 329–330

resetting
adjustments, 128
Photoshop tool defaults, 260

resizing
photograph layers, 211
photos in layered composite, 202

resolution
selecting for exported Lightroom 

photos, 72
setting External Editing preferences 

for, 28, 30
retouching in Photoshop, 298–333. 

See also portraits
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about, 4
lesson files for, 300
moving content, 301–305
simulating shallow depth of field with 

Iris Blur, 323–328
tools for removing content, 305–311
when to do, 301
working with portraits, 312–322

RGB files
color channels for, 278, 297
converting to black and white, 51, 54
editing copy with Lightroom 

adjustments, 56–59
editing original in Photoshop, 

53–56, 75
embedding color profile in, 36
Lightroom–Photoshop workflow for, 53
making edits without Lightroom 

adjustments, 59–62
saving from Photoshop to Lightroom, 

50–51, 55
as used in book, 26

rulers in Photoshop, 201–202, 203

S

saturation
adding adjustment layer for, 269
controlling color, 151–153
effect of contrast on, 143
HSL panel sliders adjusting, 157

Saturation sliders, 152–153
saving

adjustment layers, 270
Blur Gallery masks, 326
complex selections, 261–262, 297
copyright metadata, 20, 72
embedded Smart Objects in 

composites, 217
files with linked Smart Objects,  

220–221, 222

Import presets, 21
layered Photoshop composite to 

Lightroom, 204
Lightroom files by exporting, 69–73, 75
merged HDR images, 229
metadata to files, 119, 187
RGB file from Photoshop, 50–51, 55
source JPEG files, 64, 65–66

scaling photos Smart Objects, 198
searching photographs by keyword, 

107–110
selecting

areas of image with Rectangular 
Marquee tool, 345

graduated filters, 175, 177
making with layer mask, 213–216, 239

selections and masking in Photoshop, 
240–297

adding gradient fill to image, 253–257
adjustment layers for selective 

adjustments, 258–270
changing color with fill layers, 

250–253
combining multiple selection tools, 246
decontaminating color selections, 294
inverting selections, 245, 260–263, 

282–283
isolating complex objects in 

selections, 276–286
lesson files for, 242
Magic Wand tool for, 260–261
Magnetic Lasso tool, 247
making precise selections, 4, 244
moving images to Photoshop for, 243
Pen tool, 249–250
Polygonal Lasso tool, 246–247
Quick Selection tool, 244–245, 

262–263
revealing more object detail in 

selection, 289–291
saving complex, 261–262, 297
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selections and masking in Photoshop 
(continued )

selection cleanup in Quick Mask 
mode, 248

selection shortcuts, 245, 297
working with hair, 287–296

shadows
adjusting in photographs, 145–146
type with drop, 344, 363
viewing clipping created by Blacks 

slider, 148–149
Shape menu (Photoshop), 348–349
sharpening

adjusting capture, 162–164
final output, 72
masking areas from, 259

shortcuts. See keyboard shortcuts
showing. See hiding/showing
sizing exported photographs, 71, 72
sliders in Basic panel, 134–135
Smart Collections

building, 101–103
defined, 98, 115
reviewing prebuilt, 103

Smart Filters
applying to Smart Object layers, 197, 

338, 371, 381
Iris Blur applied as, 323–328, 333
Liquify applied as, 320
retouching Smart Object with Liquify, 

320–322, 333
tilt-shift blur applied as, 328–332, 333

Smart Objects, 204–225
about embedded, 204
converting layer to, 197, 338, 366, 

371, 381
effect of changes to linked, 224, 

225, 239
embedding raw file in Photoshop as, 

204–205, 239
linked, 205, 218–225

opening Lightroom images in 
Photoshop as, 218

retouching layers converted for Smart 
Filters, 320–322, 333

scaling, 198
unlinking new copy from original, 212

Smart Previews, 13, 18
snapshots, 129–130
Solarize filter (Photoshop), 377–380
Solo mode, 123
sorting photographs. See ranking 

photographs
source files. See also duplicates

defined, 33
organizing in stacks, 33–34
saving JPEG files, 64, 65–66

special effects, 334–381
applying artistic filters, 364
creating type on path, 353–364
customizing Oil Paint filter effect, 

369–376
lesson files for, 336
opening Lightroom image as 

Photoshop layer, 337
Photoshop for, 4
radial motion blur, 365–369
solarizing black and white images, 

377–380
using vector graphics, 348–350

Spot Healing Brush tool (Photoshop)
Healing Brush vs., 333
removing content with, 309–311
tips on using, 166

Spot Removal tool (Lightroom), 
164–167, 301

stacking preferences, 33–34
star ratings, 96–98, 101–103
storing photographs

archiving photographs, 18
dedicated drives for, 14

Survey view, 85
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switching catalogs, 13
Synchronize dialog, 66
Synchronize Settings dialog, 89, 235
synchronizing

global adjustments in Lightroom, 194
merged HDR images, 226–227
most selected previews, 88
preparing panoramic images for, 

233–235
spot removal, 167

T

TAT (Targeted Adjustment tool) 
(Lightroom)

HSL panel, 157–158
Tone Curve panel, 154–155

Temperature slider, 138
templates for filenames, 24–25, 34–35
text. See type
textures

adding to book cover composite, 
338–339, 351

blending, 211–212, 239
embedding photo in layer for, 

209–210
gradient, 351
selecting for Content-Aware Move 

tool, 302
Thaw Mask tool (Photoshop), 318
32-bit HDR images, 226–233

bracketing multiple exposures for, 226
cropping, 232
tone mapping, 230–231

thumbnails
clicking frame to select, 91
exclamation point on, 55, 110
filenames displayed above, 43
flagging, 93–96
importing checked, 18
star ratings for, 96–98

TIFF files
about, 26–27
JPEG vs., 29–30, 64
saving JPEG source files as, 65–66
saving raw file as, 75

Tilt-Shift Blur filter (Photoshop),  
328–332, 333

Tint slider, 138
tone

adjusting with Basic panel, 134–135
Auto adjustments for, 141
highlight adjustments with Whites 

and Blacks sliders, 147–149
remapping values with Solarize filter, 

379
tone mapping HDR images, 230–231

Tone Curve panel, 154–156
toolbar (Lightroom)

Auto Dismiss check box on, 139
choosing Before and After buttons 

from, 132–133
Develop module, 121, 165
hiding/showing, 83, 115, 121
Library module, 83–86, 115
selecting color labels from, 85, 97

tools. See also specific tools
combining multiple Photoshop 

selection, 246
Lightroom vs. Photoshop for local 

adjustments, 120, 173–174, 
189, 193

Photoshop vs. Lightroom editing, 49
resetting Photoshop defaults, 260

transparent pixels in Lightroom, 220
type

adding to curved path, 355–356
color fill for, 345–346
drop shadows for, 344, 363
editable Photoshop, 353
flipping inside path, 357, 359
inserting on book cover, 352–353
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type (continued )
layer masks modifying shape of, 

341–342
positioning on path, 357–359, 381
resizing text on path, 360–364

U

undoing Lightroom adjustments, 126–131
unlinking

layer from layer mask, 343, 381
new image from original Smart 

Object, 212
updating

Camera Raw plug-in, 37–38
process version, 136

upright lens corrections, 170

V

vector graphics
adding to book cover, 348–350
adjusting type position on shape, 

357–359
placing type on vector shape, 355–356
using vector paths, 353

vertical lens corrections, 171
Vibrance slider, 151–152
video, 14
vignetting

adding with Radial Filter tool, 
182–183

correcting, 258
Post-Crop Vignette feature vs. Radial 

Filter tool for, 182
wide-angle lens and, 236

visibility
clipping masks and layer, 347
turning on/off layer, 338

Visualize Spots feature, 165

W

warning dialogs. See error messages
warning icon when zooming, 160
watermarks, 72
white balance

adjusting for solarized image, 379
Basic panel adjustments for, 134
changing JPEG, 141
controls for adjusting, 137–141, 189
modifying with White Balance 

Selector tool, 139–141
previewing adjustments in Navigation 

panel, 140
Temperature and Tint slider changes 

for, 138
White Balance Selector tool (Lightroom), 

139–141
Whites slider, 147–148
workflow. See also combining 

Lightroom–Photoshop photos; 
Lightroom–Photoshop roundtrips

alternative Lightroom–Photoshop, 74
customizing filter effect in Lightroom 

and Photoshop, 369–376
differences between Lightroom and 

Photoshop, 1–2
importing photographs, 15–25
Lightroom’s strengths in, 2–3
moving objects from Lightroom to 

Photoshop, 301–311
passing RGB file to Photoshop, 53
Photoshop’s strengths in, 4, 243
sculpting portraits, 312–322
typical Lightroom–Photoshop 

roundtrip, 40, 41
using Develop module first, 119–120

workspace
Develop module, 120–121
Library module, 79–90
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Z

zooming
and panning images, 87, 124–126
shortcuts for, 165
warning icon when, 160
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